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Preface

Contents
The information in this manual may contain typographical errors or 
technical inaccuracies and is subject to change without notice. 
Modifications may also be made to the product described in this 
manual at any time.

Statement of Proper Use
The AutoTrace® SPE Workstation automates cartridge 
conditioning, rinsing, sample addition, and the cartridge elution 
steps of solid phase extraction (SPE). The workstation processes 
up to six samples through its unique fluid management system. It 
can be used for all solid phase extraction water methods.

WARNINGS

• To reduce the risk of electric shock, do not remove the cover. No 
user-serviceable parts are inside. Refer to qualified service 
personnel.

• Use this product only in the manner described in this manual. 
When used in a manner other than specified, the safety 
precautions may be impaired.

Contact Us
If you have a question about this product that is not answered in 
this manual, or if you need assistance regarding this product, 
please contact Dionex Technical Support. In the U.S., call 1-800-
346-6390. Outside the U.S., call the nearest Dionex office.

Before you call, you should have the following information available 
for the Technical Support Representative:
• Product serial number
• Software version (found by choosing About from the main Help 

menu)
• If applicable, the error code reference number shown on the 

product’s LCD display or from the database event log
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FCC
This device complies with part 15 of the FCC (United States Federal 
Communications Commission) Rules. Operation is subject to the 
following two conditions:
• This device may not cause harmful interference.
• This device must accept any interference received, including 

interference that may cause undesired operation.

CE
This device complies with all CE rules and requirements.

NOTE

Changes or modifications to this equipment not expressly approved 
by the party responsible for compliance could void the user’s 
authority to operate the equipment.
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Table of Symbols
Table 1 contains symbols that identify particularly important 
information and alert you to the presence of hazards. Some of 
these symbols may not appear in this manual or on the product it 
describes:

Table 1. Important Symbols 

Symbol Description

DANGER: An imminently hazardous situation which, 
if not avoided, will result in death or serious injury.

WARNING: Caution, risk of danger. Refer to the 
user documentation.

NOTE: A cautionary statement; an operating tip or 
maintenance suggestion; may result in instrument 
damage if not followed.

Hazardous voltage; risk of shock injury.

Crush hazard. Risk of body parts, hair, jewelry, or 
clothing getting caught in a moving part.

Risk of puncture injury.

Risk of eye injury; wear safety glasses.

Risk of fire.

Risk of poison.

Risk of explosion.

Hazardous fumes.

Hot surface; risk of burns.

Laser light; avoid exposure. Risk of eye injury.

Lifting hazard. May result in injury.
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Protective ground symbol.

Ground symbol.

Fuse.

Alternating current.

On (supply).

Off (supply).

CE compliance mark.

Signifies that the unit has passed safety tests for 
grounding, power line transience, and current 
leakage.

Input.

Output.

Equipment 
labels are 
color coded:

Yellow  Caution, risk of danger 
Red  Stop
Blue  Mandatory action 
Green  Safe condition or information

Helpful hints, additional information

Table 1. Important Symbols (Continued)

Symbol Description
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Installation

Parts Listing
The Dionex AutoTrace SPE Workstation is available in two 
versions: Cartridge and Disk. The workstation comes with the 
following parts:
• Workstation (Cartridge or Disk)
• Sample Rack, 6-position
• Waste Containers (2)
• Startup Kit

Unpacking
Unpack the shipping container and verify that all items listed above 
are present. If anything is damaged or missing, contact Dionex 
Technical Support (see “Contact Us” on page 3). 

Record the Serial Number
Record the workstation's serial number. The serial number is on the 
back of the workstation. This information is required when you call 
Dionex Technical Support.

Installation Overview
Installing the AutoTrace Workstation involves the following steps:

1 Review the specifications.

2 If necessary, convert the workstation voltage.

3 Prepare the work area and position the workstation.

4 Make solvent connections.

5 Install the waste drain and tubing.

6 Connect the exhaust hose and gas supply. 

7 Check compression screws for tightness.

8 Power up the workstation.

9 Provide access to a computer.

10 Install the AutoTrace software.
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Tools Required
If you need to convert the workstation from 120 VAC, have available 
a small flat-blade screwdriver, a small Phillips screwdriver, and 
needle-nose pliers. If any of the tubing lengths need to be cut, you 
need wire cutters or scissors.

Review Specifications
Review “Specifications” on page 160 before you begin the 
installation.

Converting Voltages
If you need to convert your AutoTrace Workstation's voltage to a 
voltage other than the factory-configured 120 VAC, refer to “Voltage 
Conversion” on page 155.

Prepare the Work Area
WARNING

The appliance inlet is the disconnecting device. Place the device or 
equipment in a manner so that the disconnecting device is 
accessible at all times.

To prepare the work area for AutoTrace installation:

1 Provide a level, stable, and flat surface with enough room to 
accommodate the workstation's 23 in (57 cm) width, 27 in 
(69 cm) height, and 25 in (63.5 cm) depth.

2 Make sure there is enough room for the 12 x 14 in (30 x 36 cm) 
sample rack on the right side of the workstation.

3 Provide an additional 2 to 3 sq. ft. (1 sq. meter) of space on the 
left side of the workstation for the solvent reservoirs.

4 Provide an environment with the following:

Operating 
Temperature

50 to 104°F (10 to 40°C)

Relative Humidity 20-80%
Operating Altitude -200 to 10,000 ft (-61 to 3048 meters)
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Prepare the Work Area (Continued)
5 Using at least two people, carefully place the workstation on the 

work area. If necessary, refer to the unpacking slip for 
instructions on how to correctly lift the workstation.

WARNING

At least two people are required to lift the AutoTrace Workstation 
onto the work area.

Connect the Solvent Reservoirs
To connect the solvent reservoir bottles to the solvent tubing lines 
on the left side of the workstation:

1 Position the reservoir bottles to the left side of the AutoTrace 
Workstation, keeping the following in mind:
• You must position the reservoirs within reach of the tubing 

that extends from the left side of the workstation.
• The most precise liquid transfer occurs with the solvent 

reservoirs positioned slightly higher than the workstation's 
12-port valve. Dionex recommends that you do not place the 
solvent reservoirs on the top of the workstation.

NOTE

You must provide up to five suitable containers for your solvents. 
The supplied plastic bottle should only be used for water. Do not 
use the bottle for solvents, or plastic may appear in your 
chromatogram.

2 Uncap the solvent reservoirs and fill them with the required 
solvents.

3 Remove the tubing weights and barbed fittings from the Startup 
Kit.

4 Insert the end of the tubing from solvent port #1 through the hole 
in one of the reservoir caps. Cut the tubing length, if necessary, 
to avoid slack or kinks in the solvent lines.

5 Push the tubing end through the small hole in the top of one of 
the tubing weights until the tubing extends through the opposite 
end, as shown in Figure 1.
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Connect the Solvent Reservoirs (Continued)

Figure 1. Tubing in Tubing Weight 

6 Push a barbed fitting into the end of the tubing, as shown in 
Figure 2.

Figure 2. Barbed Fitting

NOTE

To hold the tubing in your fingers while installing the barbed fitting, 
grasp the tubing using a flat rubber band or piece of emery cloth.

7 Gently pull the tubing upward until the barbed fitting seats itself 
within the recess of the tubing weight, as shown in Figure 3.

Small Hole

Tubing Weight

Barbed
Fitting
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Connect the Solvent Reservoirs (Continued)

Figure 3. Pulling Tubing Upward

8 Cap the bottle and adjust the length of tubing until the weight 
touches the bottom surface of the reservoir, as shown in 
Figure 4.

Figure 4. Tubing Weight in Reservoir

9 Repeat steps 4 through 8 for each reservoir to be used.

Pull upward

Recessed Area

Tubing Weight
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Install the Waste Drain and Tubing
To install and orient the waste drain, and connect the solvent and 
waste tubing:

1 Locate and remove the waste drain from its bubble-pack bag in 
the Startup Kit, as shown in Figure 5.

Figure 5. Waste Drain

2 Determine whether you want the waste tubing to extend from 
the workstation's left or right side, and then orient the waste 
drain's hose fittings to the appropriate side. Install the waste 
drain onto the elution station's two ball studs, making sure the 
waste drain snaps into place and sits flush on the base plate, as 
shown in Figure 6.

Figure 6. Ball Stud and Base Plate

3 Push the waste drain toward the back of the workstation. It only 
moves about 1/8 in (3 mm). This correctly positions the drain 
under the manifold.

Waste DrainHose Fittings

Ball Stud

Base Plate



Installation 17

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Install the Waste Drain and Tubing (Continued)
4 Locate and remove the two 3-ft (0.9-m) pieces of waste tubing 

with caps provided in the Startup Kit. One is used for water 
waste, the other for solvent waste.

5 With one hand supporting the waste drain, install the water and 
solvent waste tubing onto the drain's hose fittings, as shown in 
Figure 7.

Figure 7. Waste Tubing Connections

6 Route the two waste lines as follows:

a Connect the cap of the solvent waste tubing (the tubing 
connected to the front drain trough) to one of the supplied 
waste containers, making sure the waste container tubing 
never drops below the level of the waste container cap.

b Connect the cap of the water waste tubing (the tubing 
connected to the rear drain trough) to the remaining waste 
container, making sure the waste tubing never drops below 
the level of the waste container cap. If you route the water 
waste tubing to a drain, make sure you follow the same 
tubing guidelines.

If necessary, cut the tubing to the desired length with wire 
cutters or scissors.

7 Locate the tubing port labelled “WASTE” found directly below 
the five solvent tubing lines on the left side of the workstation, 
as shown in Figure 8.

Water Waste Tube (rear drain)

Solvent Waste Tube (front drain)
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Install the Waste Drain and Tubing (Continued)

Figure 8. Waste Tubing Port

8 Insert the waste tubing from this port into one of the bottles 
supplied with the workstation, keeping the following in mind:

a Make sure the end of the tubing extends just below the top 
of the container.

b Avoid sharp turns and uphill pieces of tubing from the 
workstation to the container.

Waste Port
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Connect the Exhaust Hose
If the eluted solvents need to be vented, use the workstation's 
internal fan to safely vent solvent vapors. To connect the 
workstation's exhaust hose:

1 Connect the exhaust hose to the workstation's exhaust port by 
sliding and rotating the hose onto the port, as shown in Figure 9.

 

Figure 9. Exhaust Port

2 Route the hose to a suitable vent location. If necessary, use wire 
cutters or scissors to cut any excess hose as required.

Exhaust Port
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Connect the Gas Supply
To connect the gas supply to the workstation's gas inlet:

1 Locate the 10-ft (3-m) length of 1/8-inch ID x 3/16-inch OD 
tubing pieces and the 1/8-inch Quick-disconnect fitting in the 
Startup Kit. Push the barbed end of the fitting into one end of the 
tubing, as shown in Figure 10.

Figure 10. Barbed Fitting on Tubing

2 Connect the open end of the Quick-disconnect fitting (see 
Figure 11) to the gas inlet on the lower-left side of the 
workstation (see Figure 12).

Figure 11. Quick-Disconnect Fitting
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Connect the Gas Supply (Continued)

Figure 12. Gas Inlet

3 Using the supplied ¼-inch NPT x 1/8-inch barb fitting, connect 
the other end of the tubing to the gas supply.

4 Turn on the gas supply. The gas supply must be clean and 
filtered with an incoming pressure of no more than 100 psi 
(6.9 bars). 

5 Before operating the AutoTrace Workstation, you need to set 
the workstation pressure to 10 psi (0.7 bars). Refer to 
“Operation” on page 97 for instructions.

Gas Inlet
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Check the Compression Screws
To check the tightness of the workstation's compression screws:

1 Open the workstation's side door and locate the white 
compression screws on the 3-way valve, 12-port valve, 
switching valves, and syringes, as shown in Figure 13.

 

Figure 13. AutoTrace Left Side View

2 Make sure each screw is finger tight.

3 Perform the same check for the compression screws on the 
pumps and column holders on the front of the workstation.

12-Port Valve

3-Way Valve

Compression ScrewSwitching Valves



Installation 23

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Power Up the Workstation
To power up the workstation:

1 Plug the AC power cord securely into the receptacle on the right 
side of the workstation.

2 Plug the 3-pronged end of the power cord into an appropriate 
AC power source.

WARNING

• Only plug the AC power cord into a properly grounded outlet. 
• Only use a standard IEC 320-style power cord appropriate for 

your country.
• The AutoTrace Workstation does not require a dedicated AC 

line. However, you should provide a clean AC source similar to 
one used for computers and other equipment. A UPS is 
recommended where power outages or brownouts frequently 
occur (see ordering information in “Ordering Supplies” on 
page 163).

3 Turn on the AutoTrace Workstation.

Computer Access
While a computer is not required for AutoTrace control, you must 
have access to a computer to write AutoTrace methods and 
download AutoTrace methods. The computer must have the 
following specifications:
• Compatible with Microsoft® Windows 2000® SP4 and Windows 

XP® SP1 Professional operating systems, including the latest 
released service packs.

• Follow Microsoft's recommendation for the computer 
specification, with the following minimum hardware 
specifications:
Windows 2000

— CPU = 400MHz
— RAM = 128M

Windows XP
— CPU = 650MHz
— RAM = 192M
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Computer Access (Continued)
You can also install the AutoTrace software on a local area network 
(LAN). 

Software Installation
NOTES

• To install this software, you must be assigned to the Windows 
Administrator group.

• An operator must be assigned to the Windows Power User 
group in order to use the software.

To install the AutoTrace software on your computer:

1 Start Windows and insert the CD in the CD drive.

2 From the Microsoft Windows operating system Start menu, 
select Run... and click the Browse button.

3 Navigate to the CD drive.

4 Select the setup.exe file and click the Open button.

5 Click the OK button. Follow the on-screen instructions. The 
software is installed in the default directory of C:\Program 
Files\Dionex\AutoTrace SPE Workstation.

NOTE

If the software is installed in a directory other than C:\Program 
Files\Dionex\AutoTrace SPE Workstation, the INI file has to be 
modified as described in “INI File” on page 25.

6 Open the AutoTrace software by choosing from the Windows 
Start menu Programs→Dionex→AutoTrace SPE Workstation.

7 Close the AutoTrace software.
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INI File

The AutoTrace software program uses a file named AT.INI which is 
loaded by starting the program. AT.INI must always be in the 
working directory (the default is C:\Program Files\Dionex\AutoTrace 
SPE Workstation). Modifications can be made using an ASCII editor 
(such as Windows Notepad).

NOTE

Blank spaces are not allowed in the AT.INI file to the left of an equal 
sign and before the first letter to the right of an equal sign.

The AT.INI file contains specifications concerning path name of the 
necessary data bases [DATABASES] and the language adjustment 
[AUTOTRACE]. An example of an AT.INI file follows:

[DATABASES]
Database_Data=ATDATA.MDB
Data_Dir=C:\Program Files\Dionex\AutoTrace SPE 
Workstation\data\
[AUTOTRACE]
ATDrive=A
Language=1
Version=1 (See Note below)
Comm_Port=1

NOTE

The “Version” option identifies whether you are running a Cartridge 
(Version=1) or Disk (Version=2) AutoTrace Workstation. If you have 
both types of units, you can run the AT software for either unit by:
• Changing the Version option to the correct value in the INI file,
• Saving the INI fil, and
• Starting the AutoTrace software.

If the program is installed in a directory other than C:\Program 
Files\Dionex\AutoTrace SPE Workstation, you must modify the 
following entries:

Database_Data=C:\<DIRECTORY_NAME>\ATDATA.MDB
Data_Dir=C:\<DIRECTORY_NAME>\

where <DIRECTORY_NAME> identifies the directory where the 
files reside.
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Overview
This section provides a general description of the workstation 
capabilities, parts and functions, and liquid flow.

Description
The AutoTrace SPE Workstation performs large-volume solid phase 
extraction using a variety of manufacturers' 1 mL, 3 mL, 6 mL, or 
glass (6 or 8 mL) syringe-type SPE columns or 47 mm disks.

Automate the method by using the workstation to:
• Condition the column or disk
• Load sample onto the column or disk
• Rinse the column or disk
• Dry the column or disk
• Elute the sample

Menu Software
Easy-to-use software is provided with the workstation for setting the 
operational parameters and writing the specific method steps that 
automate the method. Descriptions of the parts of the software are 
provided in “Software” on page 58.

The software includes diagnostic methods run on the workstation to 
assist in maintaining optimal performance. More details on 
diagnostics are provided in “Diagnose Problems” on page 113. 

Solvent Selection
When writing an AutoTrace method using the menu software, up to 
five solvents may be designated for the liquid sequences used in 
column precondition, sample loading, column rinsing, and elution.

Flow Rate Control
Through setup parameters, the workstation controls the flow rates 
of solvent and sample in each solid phase extraction step of the 
written method.
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Standard Operations
The standard solid phase extraction operation steps used in a 
method are described briefly below.

Optional Operations
These optional operation steps can be used in a method.

Operation Description
Conditioning the Column or 
Disk

Use CONDITION COLUMN or CONDITION DISK to 
pass the solvent through the column or disk and direct 
the effluent to waste.

Loading the Sample Use LOAD SAMPLE to pump sample from the sample 
container to the column or disk for extraction. 

Rinsing the Column or Disk Use COLUMN RINSE or DISK RINSE after loading the 
sample path and column or disk, and direct the effluent 
to waste.

Washing the Syringe 
Solvent

Use WASH SYRINGE to prewash the liquid handling 
syringe with the next solvent of choice to waste.

Eluting the Sample Use ELUTE TO COLLECT to pass solvent through the 
column or disk and direct eluent into the collection 
container.

Operation Description
Rinsing the Sample 
Container

Use RINSE SAMPLE CONTAINER to manually add 
solvent and swirl the sample container before 
continuing.

Drying with Gas Use DRY WITH GAS to flow gas through the column, 
clearing the path of residual water.

Pausing Operation Use PAUSE to delay operation, or stop operation and 
signal manual intervention.

Increasing Absorption Time Use ELUTE TO SOAK before an ELUTE TO COLLECT 
step to allow sample to soak the column.

Performing Multiple Elution 
Steps

Use ELUTE TO COLLECT, 2nd TUBE, or multiple 
ELUTE TO SOAK or ELUTE TO COLLECT steps as 
required by the method.

Cleaning the Sample Path Use CLEAN SAMPLE PATH method steps between 
sample batches to prevent cross-contamination.

Concentrating the Sample Use CONCENTRATE SAMPLE for automated 
concentration of the eluent.



Overview 28

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Workstation Diagram - Front View

Figure 14. Front View

Parts and Functions - Front View

4

1

2

3

5 6 7

9 108

# Part Function
1 Sample Pumps Pumps sample from sample containers to 

switching valves.
2 Column/Disk 

Holders
Holds the SPE columns or disks 
(depending on the workstation’s type) for 
the extraction process.

3 Elution Station Collects aqueous effluent, solvent effluent, 
or sample effluent on the elution station. 
These components are shown in detail in 
the next view. 
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4 Front Panel Communicates workstation status to the 
operator.

5 READY Light A steady light indicates power is ON to the 
unit; a flashing light indicates a system 
error.

6 RUN Light Indicates a method is running.
7 ERROR Light Indicates that operation has stopped due 

to an error condition.
8 LOAD Button Used to download a method from the PC.
9 PAUSE Button Used to stop the workstation after it 

completes the step it is performing.
10 CONT Button By pressing CONT twice slowly, 

downloads a method from the PC.

# Part Function
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Workstation Diagram - Left Side View

Figure 15. Left Side View

Parts and Functions - Left Side View

4

1

2

3

5 6 7

9

8

12

11

10

# Part Function
1 Solvent Ports (Behind door, not shown) Input ports for 

five solvents.
2 Waste Port (Behind door, not shown) Output port for 

system waste from purging solvent lines 
and/or washing the liquid handling 
syringe.

3 Gas Inlet Input for the clean gas supply.
4 Air Syringe Draws in and delivers air that follows 

sample or solvent transfer (to assure 
transfer is complete).

5 Liquid Handling 
Syringe

Draws in and dispenses solvent through 
the workstation.
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6 Gas Regulator 
Knob

Regulates gas pressure in the workstation 
that is used for the drying column and 
sample concentration.

7 Gas Pressure 
Gauge

Indicates the gas pressure set by the 
knob.

8 Elution Rack Holds tubes or vials for collection of 
eluent.

9 Elution Station Collects effluent to one of two waste 
positions or collects eluent into collection 
container by moving into the appropriate 
position.

10 12-Port Valve Controls the flow of air, solvent, and 
waste - whatever is specified by the 
method step.

11 Switching Valves Directs the flow of gas, solvent, or sample 
to the column holders.

12 Air Valve (3-Way 
Valve)

Draws in air for the air syringe.

Aqueous Waste 
Tubing (not 
shown)

Routes aqueous effluent to waste.

Solvent Waste 
Tubing (not 
shown)

Routes sample and solvent effluent to 
waste.

# Part Function
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Workstation Diagram - Right Side View

Figure 16. Right Side View

Parts and Functions - Right Side View

4

1

2

3

5

# Part Function
1 Sample Input Lines Connects the workstation to sample 

containers.
2 Power Switch Turns the workstation On and Off.
3 Power Entry Port Provides a power connection and holds 

fuses.

WARNING

The appliance inlet is the disconnecting 
device. Place the device or equipment 
in a manner so that the disconnecting 
device is accessible at all times.

4 Exhaust Port Outlet for routing solvent vapors to a 
suitable vent location.

5 Communications 
Port

Connects the communication cable 
from the AutoTrace Workstation to the 
PC.
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Software Diagram
The AutoTrace software diagram is shown in Figure 17.

Figure 17. AutoTrace Software Diagram

Software Files and Functions

Software files and functions are listed in Table 2.

Software CD

Communication
Cable

AutoTrace

PC

Table 2. Software Files and Functions 

Files Function
Software CD Files Installs the AutoTrace software on 

the computer.
Doc Folder Contains the user’s guide.
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Workstation Interconnection Diagram
Figure 18 shows a simplified view of the main AutoTrace 
components and their connections.

NOTE

The dashed box shows the pump, switching valve, column, and 
sample container for position #1 only. Refer to the flow charts and 
diagrams that follow for details on the SPE process.

Figure 18.  Interconnection Diagram
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SPE Process
The flow charts and associated diagrams that follow show how the 
AutoTrace Workstation processes a typical SPE method.

Figure 19. Condition Column: Liquid Handling and
Air Syringes Fill Flow Chart

Start

12-port valve

SPE method

selects one of five
solvents

Liquid handling and air
syringes fill with

conditioning solvent

See Figure 20

Continued...
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Figure 20. Condition Column: Liquid Handling and
Air Syringes Fill Diagram
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Figure 21. Condition Column: Liquid Syringe Dispenses 
Solvent Flow Chart

Continued...

12-port valve
switches to the
switching valve

Liquid handling
syringe dispenses

conditioning solvent

See Figure 22

Continued...
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Figure 22. Condition Column: Liquid Syringe Dispenses 
Solvent Diagram
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Figure 23. Condition Column: Air Push Flow Chart

Continued...

Air syringe pushes
conditioning solvent through

switching valve and into column

See Figure 24 for air push with
Air Factor of 1.0

See Figure 25 for air push with
Air Factor of 0.5

Continued...
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Figure 24. Condition Column: Air Push with Air Factor of 1.0 
Diagram
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Figure 25. Condition Column: Air Push with Air Factor of 0.5 
Diagram
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Figure 26. Load Sample Flow Chart

Continued...

Pump turns on and
pumps sample through

switching valve and onto
column

See Figure 27

Continued...
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Figure 27. Load Sample Diagram
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Figure 28. Column Rinse: Liquid Handling and Air Syringes Fill 
Flow Chart

Continued...

Continued...

Liquid handling syringe
fills with rinse solvent

See Figure 29
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Figure 29. Column Rinse: Liquid Handling and Air Syringes Fill 
Diagram
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Figure 30. Column Rinse Liquid Handling Syringe Dispenses 
Solvent Flow Chart

Continued...

12-port valve
switches to the
switching valve

Liquid handling
syringe dispenses

rinse solvent

See Figure 31

Continued...
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Figure 31. Column Rinse: Liquid Handling Syringe Dispenses 
Solvent Diagram
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Figure 32. Column Rinse: Air Push Flow Chart 

Continued...

Air Push rinses flow
path and column

See Figure 33

Continued...
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Figure 33. Column Rinse: Air Push Diagram
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Figure 34. Dry with Gas Flow Chart

Continued...

Switching valve
selects gas port

Gas flows through
column to dry

See Figure 35

Continued...
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Figure 35. Dry with Gas Diagram
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Figure 36. Elute to Collect: Liquid Handling and Air Syringes 
Fill Flow Chart

Continued...

Continued...

Liquid handling syringe
fills with elution solvent

See Figure 37



Overview 53

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Figure 37. Elute to Collect: Liquid Handling and Air Syringes 
Fill Diagram
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Figure 38. Elute to Collect: Liquid Handling Syringe Dispenses 
Solvent Flow Chart

Continued...

Continued...

Elution solvent is dispensed

See Figure 39
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Figure 39. Elute to Collect: Liquid Handling Syringe Dispenses 
Solvent Diagram

Pump
#1

Incoming
Sample

#1

Switching
Valve #1

SPE
Column #1

Collect

Nitrogen Manifold
Regulator

Gas

Air
Valve

Air
Vent

12-Port
Valve

Air Syringe Liquid
Handling
Syringe

Solvent 1
Solvent 2
Solvent 3
Solvent 4
Solvent 5
Waste

=Solvent
=Air
=Gas



Overview 56

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Figure 40. Elute to Collect: Air Push Flow Chart

Continued...

Air push rinses flow path
and eluent goes to
collection container

See Figure 41
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Figure 41. Elute to Collect: Air Push Diagram
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Software
This section of the manual describes how to use the software 
supplied with the AutoTrace SPE workstation, provides a method 
example, and lists some application tips.

Once you install the AutoTrace software, follow these general steps 
to automate a method:

1 Open the AutoTrace (AT) software.

2 Specify the parameter and solvent information.

3 Write a method.

4 Save the method.

5 Download the method to the AutoTrace unit.

6 Print the method.

Using the AutoTrace (AT) Program
To start the menu software, click the Windows Start button, and then 
choose Programs→Dionex→AutoTrace SPE Workstation. If 
available, you can click the AUTOTRACE icon on the desktop, 
instead.

The copyright window now appears. Close the window or wait 
5 seconds for the window to close.

The AutoTrace main window is shown in Figure 42. The main menu 
and its options are discussed in this section.

Figure 42. AutoTrace Main Window
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File Menu

The File menu contains the options shown in Figure 43.

Figure 43. File Menu
Print Setup

Change printer settings such as the standard printer, page size, and 
format.

Language

Change the language between English, German, and French.

Database

Compact - As data changes in the database, the database file can 
become fragmented and use more disk space than necessary. 
Periodically, compact the database to defragment the database file. 
The compacted database is usually smaller.

Repair - This method attempts to repair a database that was 
marked as possibly corrupt by an incomplete write operation. This 
can occur if an application is closed unexpectedly because of a 
power outage or computer hardware problem. The database won't 
be marked as possibly corrupt if the application is closed in the 
usual way.

Exit

Quit the AT program. Click the Yes button to close the software. If 
there is any window open in editing mode, make sure that you first 
save the data.

Methods Menu

Selecting Methods from the main menu opens the Setup Methods 
window. This allows you to write a new method and edit values, as 
well as print the method steps and the parameter or solvent 
settings. For more details, refer to “Writing a Method” on page 76.
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Serial-Op Menu

The Serial-Op menu contains the options shown in Figure 44.

Figure 44. Serial-Op Menu

Use the Serial-Op menu to download AutoTrace methods and utility 
methods.

NOTE

Code 8192 means that the method or utility file downloaded 
successfully. Refer to page 125 for a list of other codes.

Download Method

Downloads an AutoTrace method to the AutoTrace Workstation.
• If the editing window for methods is open, the current method is 

downloaded to the AutoTrace.
• If the method window is not open, the Find Method window 

opens. Choose the method to download by double-clicking it. 
A DOS window opens, indicating the method is being 
downloaded. The download takes a few minutes to complete, 
depending on the size of the method and if other files are 
needed during the download process. After the method is 
downloaded, either press the CONT button or power-cycle the 
AutoTrace and follow the on-screen instructions on the 
AutoTrace to run the method.

Download Utility Procedure

Downloads one of four utility methods to the AutoTrace 
Workstation:
• Purge Solvents (purges the AutoTrace solvent lines)
• Benchmark Test (tests general AutoTrace operation)
• Calibrate Pump (calibrates the AutoTrace sample pumps)
• Set Date and Time (sets the AutoTrace date and time)
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Diagnostics Menu

The Diagnostics menu contains the options shown in Figure 45. 
Use this menu to copy a diagnostic file onto the AutoTrace 
Workstation. For more details, refer to “Diagnose Problems” on 
page 113.

Figure 45. Diagnostics Menu
Initialization

Diagnose the reason for an AutoTrace failing to initialize properly.

Syringes: Adjust Liquid Syringe

Check the integrity of the liquid handling syringe drive mechanism.

Syringes: Adjust Air Syringe

Check the integrity of the air syringe drive mechanism.

Valves: Check 12-Port Valve

Confirm the positioning integrity of the 12-port valve.

Valves: Purge Solvents

Prime or drain the liquid lines.

Login/Logout Menu

The Login/Logout menu contains the options shown in Figure 46.

Figure 46. Login/Logout Menu
Login

Register as a user, with access rights given by the system 
supervisor. Selecting Login from the menu opens the User 
Identification window (see Figure 47). Type a User ID and 
Password, and then click the OK button. The default User ID is 
ADMIN and the default password is ADMIN.
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Login/Logout Menu (Continued)

Figure 47. User Identification Window

If the registration is successful, your User ID displays in the status 
bar at the bottom of the window.

Change Password

To change a password, open the User Identification window and 
click the Change button. The Change Password window opens, as 
shown in Figure 48. Type the old password, the new password, 
repeat the new password, and click the OK button. 

Figure 48. Change Password Window
Logout

Log out of the software by selecting Logout from the menu. Your 
access rights are changed to READ-ONLY mode. The status bar 
shows “No user logged in”.
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Data Menu

The Data menu contains the options shown in Figure 49. 

Figure 49. Data Menu

Setup Parameters

Set parameters to meet method specifications. For more 
information, refer to “Specifying Parameter and Solvent Information” 
on page 69.

Name Solvents

Specify solvent information. For more information, refer to 
“Specifying Parameter and Solvent Information” on page 69.

Setup AutoTrace Commands

Change standard options for method steps. Only the values in the 
Std. column can be changed. The Setup AutoTrace Commands 
window is shown in Figure 50. (This menu option is available only if 
the user type selected in the Setup User Data window (see 
Figure 51) corresponds to Service.)

Figure 50. Setup AutoTrace Commands Window
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Data Menu (Continued)

Setup User Data

The Setup User Data window (see Figure 51) allows you to edit 
user data such as user name, User ID, Password, user type, and 
access rights. This menu option is available only if your user type 
corresponds to Administrator.

Figure 51. Setup User Data Window

To change the user type, choose the user type in the User Type 
box on the left. After choosing the user type, the corresponding tab 
on the right switches to User, Service, or Administrator.

User - Manage methods, parameter and solvent settings, serial 
operations, and diagnostics.

Service - Manage additional command settings (in the Setup 
Commands menu option).

Administrator - Manage additional user data.

The access rights for the user type are displayed on the right of the 
Setup User Data window:
• Read-only mode
• Print mode
• Write mode
• Delete mode



Software 65

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Windows Menu

The Windows menu contains the options shown in Figure 52.

Figure 52. Windows Menu

Cascade

Stack and overlap the windows diagonally. Cascade allows the 
entire top window to be visible, but only the title bars of the 
remaining windows are visible.

Overlap Horizontal

Stack and overlap the windows horizontally.

Overlap Vertical

Stack and overlap the windows vertically.

Arrange Icons

If any windows are minimized, use Arrange Icons to arrange the 
icons neatly at the bottom of the main window.

Help Menu

The Help menu contains the options shown in Figure 53. 

Figure 53. Help Menu

Contents

Shows the Help contents and the index. While working with the 
program, open the Help window by pressing the F1 key.

About

Opens the About window, which contains additional information 
about the AutoTrace system.
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Running AutoTrace Utility Methods
A number of utility methods are provided by the AutoTrace 
software. These utilities are used for:
• Purging the AutoTrace solvent lines
• Setting the AutoTrace date and time
• Testing general AutoTrace operation
• Calibrating the AutoTrace sample pumps

To run a utility method:

1 From the AutoTrace main menu, choose Serial-OP→Download 
Utility Procedure.

2 Click one of the four buttons (see Figure 54) to select an 
AutoTrace utility.

Figure 54. Download Utility Method Window

3 The selected utility will be downloaded to the AutoTrace. Press 
the CONT button twice slowly on the AutoTrace to run the 
utility. Allow at least 2 seconds between presses.

Purging the Solvent Lines Utility

Purge the entire length of the solvent lines any time they are dry. 
(For example, when the workstation is being used for the first time 
each day or whenever the solvent supply runs out.) To purge the 
solvent lines, download the Purge Solvent utility method provided or 
write your own purge method. Purging the sample lines is described 
in “Customizing a Method to Purge Less than Five Solvent Lines” 
on page 67.
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Customizing a Method to Purge Less than Five Solvent Lines
To save a method to purge the solvent lines when you will not be 
using all five solvent ports, do the following. For more details, refer 
to “Writing a Method” on page 76.

1 From the AutoTrace main menu, choose Methods.

2 Click the New button.

3 Name the method “Purge Solvent Path - Custom”.

4 Specify the maximum number of samples that can be run.

a Select WASH SYRINGE once for each solvent port being 
used. Specify a volume of 5 mL.

b For example, when using three solvent ports, the purge 
method would consist of these steps:
• Process “3” samples using the following method:
• Step 1: WASH SYRINGE with 5 mL of SOLVENT 1
• Step 2: WASH SYRINGE with 5 mL of SOLVENT 2
• Step 3: WASH SYRINGE with 5 mL of SOLVENT 3

5 Click the Save button.

6 From the AutoTrace main menu, choose Serial-OP→Download 
Method.

Setting the Date and Time Utility

The AutoTrace clock is factory-set at USA Eastern time. If your time 
zone differs, save and run this method to reset the real-time clock in 
the workstation as follows:

1 From the AutoTrace main menu, choose Serial-OP→Download 
Utility Procedure.

2 Click the Set Date and Time button. The system date and time 
(+ 2 minutes) of your computer is written to the AutoTrace 
Workstation.

3 After about one minute, a beep signals that the workstation is 
ready to update its date and time using the values from the 
method.
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Setting the Date and Time Utility (Continued)

4 Press the CONT button on the workstation’s front panel display. 
The workstation’s date and time are immediately updated.

Once set, the time is maintained even when power to the 
workstation is turned off.

Testing General Operation (Benchmark Test) Utility

1 From the AutoTrace main menu, choose Serial-OP→Download 
Utility Procedure.

2 Click the Benchmark Test button.

NOTE

Refer to “Benchmark Test Utility” on page 141 for instructions on 
how to run this utility.

Calibrating the Sample Pumps Utility

1 From the AutoTrace main menu, choose Serial-OP→Download 
Utility Procedure.

2 Click the Calibrate Pump button.

NOTE

Refer to “Calibrating Sample Pumps” on page 139 for instructions 
on how to run this utility.

Creating a Method to Clean the Sample Lines with Solvent and DI Water
Before beginning routine operation with the AutoTrace SPE 
Workstation, a method is needed for cleaning the sample lines. If 
the method does not end with CLEAN SAMPLE PATH steps (see 
“Clean Sample Path” on page 87), run this method between sample 
runs to clean the lines. Also, whenever the workstation is idle for a 
period of time, run this method to clean the lines and leave the lines 
filled with DI water. To create the method, perform the following 
steps. For more details, refer to “Writing a Method” on page 76.

1 From the AutoTrace main menu, choose Methods.

2 Click the New button.

3 Name the method “Clean Sample Path - Solvent & Water”.
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Creating a Method to Clean the Sample Lines with Solvent and DI Water 
(Continued)

4 Specify the maximum number of samples that can be run.

5 Choose Clean Sample Path. Specify a volume of 25.0 mL and 
select Solvent Waste as the Waste Position.

6 If the solvent used for the first Clean Sample Path step is 
immiscible in water, repeat the Clean Sample Path selection. 
Specify a volume of 25.0 mL and choose Solvent Waste as the 
Waste Position. Otherwise, skip to step 7.

7 Repeat the Clean Sample Path selection. Specify a volume of 
25.0 mL and choose Aqueous Waste as the Waste Position.

For each CLEAN SAMPLE PATH step, the workstation pauses 
for the sample lines to be placed in a beaker of:
• Solvent for the first step
• Intermediate solvent for the second step, if necessary
• Water for the last step

8 Choose Dry With Gas and specify a time of 0.5 minutes to 
remove the water from the solvent path. This step is very 
important because it removes the water between the switching 
valve and the column.

WARNING

Only inert gases such as nitrogen, argon, or compressed air (free 
from oil) should be used.

9 Click the Save button.

10 From the AutoTrace main menu, choose Serial-OP→Download 
Method.

Specifying Parameter and Solvent Information
Specify the parameter and solvent information, using the two 
choices available from the DATA program option.

Default Entries

The two choices from the DATA program option are SETUP 
PARAMETERS and NAME SOLVENTS, beginning with default 
entries.
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Default Setup Parameter Entries

If the method does not specify flow rates1, begin with the default 
setup parameters. Observe workstation operation and examine the 
recovery data to determine if any modifications need to be made.

Additional Parameter Information

For tips on parameter settings, refer to the Help screens by 
pressing the F1 key. Also review the “Application Tips” on page 93.

Default Solvent Names

You can choose to keep the default solvent names (SOLVENT 1, 
SOLVENT 2, etc.) or specify the actual names of the solvents to be 
used. Specify “Not Used” for any solvent ports that do not have 
solvents connected.

These names appear in a selection list whenever you write a 
method step requiring solvent. The name of the selection appears 
in the method step display and printout.

Recalling Default Entries

You can recall global default entries at any time by pressing the 
Default button on the Setup Parameters window that is accessed 
from the Data menu. Global default parameters include flow rates, 
SPE parameters, and workstation parameters. See Figure 55.

1. Contact the column or disk manufacturer for their 
recommended flow rates.



Software 71

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Recalling Default Entries (Continued)

Figure 55. Global Setup Parameters Window

NOTE

This window is not the same as the local Setup Parameters window 
(which contains parameters that are local to the specific method) 
that can be opened from within the Setup Methods window. The 
Default button does not appear on the local Setup Parameters 
window.
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Changing Setup

A brief description of each setup parameter is included in:
• Table 3:Flow Rate Definitions on page 73
• Table 4:SPE Parameters on page 74
• Table 5:Workstation Parameters on page 74
• Table 6:Maximum Elution Volumes on page 75

To change the setup parameters:

1 From the AutoTrace main menu, choose Data→Setup 
Parameters.

2 Click the Edit button. The Setup Parameters window opens, as 
shown in Figure 56.

Use the arrow keys to move to the field that requires changing 
and specify the new value. The window displays the minimum 
and maximum values allowed.

Figure 56. Setup Parameters Window

3 Click the Save button.

To recall the default entries, click the Default button.

Values shown in Table 3 are for both the Column and Disk versions 
of the AutoTrace Workstation, unless otherwise specified.
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Changing Setup (Continued)

Table 3. Flow Rate Definitions 

Flow Rate Definition Range
Cond Flow Flow rate at which the syringe will 

push conditioning solvent through 
the column.

0.6 to 40.0 mL/min.

Load Flow Flow rate at which the pump will 
push sample through the column.

1.0 to 30.0 mL/min. 
(Cartridge version)
2.0 to 60.0 mL/min. (Disk 
version)

Rinse Flow Flow rate at which the syringe will 
push rinse solvent through the 
column.

0.6 to 40.0 mL/min.

Elute Flow Flow rate at which the syringe will 
push elution solvent through the 
column.a b

0.6 to 40.0 mL/min.

Cond Air Push Flow rate when the air syringe clears 
liquid from the syringe and tubing 
after a conditioning step.

0.6 to 40.0 mL/min.

Rinse Air Push Flow rate when the air syringe clears 
liquid from the syringe and tubing 
after a column rinse step.

0.6 to 40.0 mL/min.

Elute Air Push Flow rate when the air syringe clears 
liquid from the syringe and tubing 
after an elution step.c d

0.6 to 40.0 mL/min.

Push Delay Time delay after liquid is pushed into 
the column path before the next 
operation begins. It allows time for 
pressure in the column to dissipate.e

0 to 999 seconds

a. If any flow rate is set too high, excessive pressure will result and the syringe 
may stall.

b. Most applications show higher recoveries at slower flow rates.
c. Air Pushes are used to evacuate the lines and ensure solvent delivery.
d. Air Push rates should initially be set equal to their corresponding flow rate. 

For example, if the Rinse Flow rate is set to 18, set Rinse Air Push to the 
same. Then, if either can be increased for better throughput without negative 
effects, your final Air Push rate may differ from its corresponding flow rate.

e. This parameter is useful when transferring viscous liquids.
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Changing Setup (Continued)

Values shown in Table 4 are for both the Column and Disk versions 
of the AutoTrace Workstation, unless otherwise specified.

Table 4. SPE Parameters 

SPE Parameter Definition Range
Air Factor Sets the distance that liquid is pushed 

beyond the 12-port valve in 
CONDITION COLUMN (or 
CONDITION DISK) and ELUTE TO 
SOAK method steps. a b

0.3 to 5.0 (Cartridge 
version)
0.0 to 5.0 (Disk version)

Autowash Vol Allows the workstation to automatically 
prewash the liquid handling syringe 
with the next solvent during operations 
such as CONDITION COLUMN (or 
CONDITION DISK), RINSE COLUMN 
(or RINSE DISK), and ELUTE.c d e

0 to 10 (zero turns 
Autowash Off)

a. Reduce this factor to decrease the amount of air between multiple 
conditioning steps.

b. Increase this factor to advance solvent and avoid soaking of the column.
c. Alternative: Place a WASH SYRINGE step in the method where needed.
d. When going between immiscible solvents in your method, use the WASH 

SYRINGE method step with an intermediate solvent.
e. Occurrence of Autowash steps appear on the front panel display during 

operation but do not appear in the method printout. Therefore, for auditing 
purposes, we suggest that you turn off Autowash (set to zero) and use 
WASH SYRINGE steps where needed.

Table 5. Workstation Parameters

Workstation Parameter Definition Range
Max Elution Maximum volume that can be eluted onto 

the collection container for safe handling, as 
listed in Table 6.

See 
Table 6

Exhaust Fan On Enable or disable the exhaust fan for solvent 
vapor removal during operation.

Y or N

Beeper On Enable or disable the workstation's beeper. Y or N
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Changing Setup (Continued)

Change Solvent Names
To change the solvent names:

1 From the AutoTrace main menu, choose Data→Name 
Solvents. The Edit Solvent Sets window opens, as shown in 
Figure 57.

Figure 57. Edit Solvent Sets Window

2 Select one item in the list of the available solvent sets on the 
left side, and then click the Edit button or click the Add button to 
create a new solvent set. Each solvent set can be named (Set 
name) and has five solvents. Up to 25 characters are allowed 
for the Set name.

Use the arrow keys to move to the field that requires changing 
and specify the name of the solvents used in your method. Up to 
15 characters are allowed for each solvent name.

NOTE

Type “Not Used” for any unused solvent port.

Table 6. Maximum Elution Volumes 

Container Maximum Volume
16 x 100 mm tube 12 mL
17 x 60 mm vial 7 mL
11 mm GC vial 1.5 mL
4 mL screw cap vial 4 mL
15 mL conical tube 20 mL
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Change Solvent Names (Continued)

3 Click the Save button.

4 To delete a complete solvent set, click the Delete button.

Writing a Method
Choose Methods from the main menu to manage the methods. The 
Setup Methods window opens, as shown in Figure 58.

Figure 58. Setup Methods Window

The last method opened displays in the Setup Methods window. To 
choose a different method, click the Load button to open the Find 
Method window (see Figure 59) and double-click the method that 
you want to open. The selected method is loaded in the Setup 
Methods window.
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Writing a Method (Continued)

Figure 59. Find Method Window

Buttons in Setup Methods Window
See Figure 58 on page 76.

Load Button

Loads an archived method from the database. 

New Button

Allows you to write a new method.

The Method window prompts for the method name, the number of 
samples to be run, and the selections for defining the method steps.

Method Name - Type a name for the method, up to a maximum of 
38 characters. Spaces and any characters can be used.

Samples - Type the number of samples to process when the 
method runs. This information is used for time-estimating purposes 
only. Specifying the number of samples causes the first line of the 
method to change.

Example for only two samples:

Step 1: Process 2 samples, using the following method steps:

Default value: 6

Solvent set - Select a solvent set with up to five solvents by clicking 
the button next to the solvent in the solvent box.
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Writing a Method (Continued)
Edit

Edit mode for the method. Any data can be changed. For details, 
refer to the New function description.

Save

Save data being changed after the New or Edit functions.

Undo

Recall the last entries before starting edit mode.

Delete

Delete a method. Before deleting, you are asked if you want to 
delete the method. After deleting the method, the method is 
obsolete and cannot be recalled.

Params

Change the setup parameters of the method. Each method has its 
own set of parameters. Parameters are initially set at default 
values. For more details, refer to “Changing Setup” on page 72.

Print

Print the method. The printout includes:
• The AutoTrace SPE software version and the method title
• A listing of the method steps
• A record of the setup parameters

Help

Press the F1 key to open the Help window.

Close

Close the Setup Methods window.
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Writing a Method (Continued)

Adding a Method Step

To add a new method step:

1 In the AutoTrace commands list on the left side of the Setup 
Methods window, double-click a step under either the Solid 
Phase Extract or Solid Phase Elute heading.

The step will be inserted in the line below the arrow.

2 Specify the volume or time in the box above the method steps.

3 If applicable, choose a waste position.

4 If applicable, choose a solvent.

Deleting a Method Step

Double-click the method step to be deleted in the list of method 
steps on the right side of the Setup Methods window.

NOTE

The first step (“Process x samples using...”) and the last step 
(“End”) can't be deleted.
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Writing a Method (Continued)

Solid Phase Extract Commands

The Solid Phase Extract commands (found on the left side of the 
Setup Methods window) specify the steps prior to sample elution. 
The solid phase extract menu is shown in Figure 60. An example 
method is provided in “Method Example” on page 90. 

NOTE

Figure 60 shows commands for the Column version of the 
AutoTrace Workstation. The Disk version of the AutoTrace 
Workstation will display the word “Disk” instead of “Column”.

Figure 60. Solid Phase Extract Menu
Condition Column or Condition Disk

To activate the SPE column or disk, specify a volume and solvent to 
be passed through the column or disk, with the effluent directed to a 
solvent or aqueous waste position.

For more than one solvent, repeat this selection as many times as 
necessary.

NOTE

After this step is performed, a small volume of air (affected by the 
Air Factor parameter setting) is used to push solvent past the 
12-port and switching valves. The air push clears the lines between 
the switching valve and column or disk of any remaining solvent 
prior to the next conditioning, column or disk rinsing, or sample 
loading step.
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Solid Phase Extract Commands (Continued)

Load Sample

To load sample onto the SPE column or disk, specify a volume of 
sample to be transferred from the sample container to the SPE 
column or disk. Sample is passed through the column or disk and 
the effluent directed to aqueous waste.

NOTES

• To get the entire sample and/or compensate for the pump's 
±2.5% accuracy, adjust the column or disk entry.

• With samples containing large amounts of solids, it is advisable 
to over-pump sample onto the column or disk by 5% to 7%. For 
example, if the desired sample volume for the LOAD SAMPLE 
step is 1000 mL, specify 1050 mL.

• If the sample contains volatile compounds, avoid sample 
evaporation during the conditioning steps by placing a PAUSE 
AND ALERT step before the LOAD SAMPLE step. See a 
description of the steps below.

Pause

To add a pause in workstation operation, select either a timed delay 
step (in minutes) or a “pause and alert” step that signals the 
operator until the CONT button is pressed.

Examples:

PAUSE AND ALERT - Use this step to alert the operator for sample 
container introduction when the workstation is done with the column 
or disk conditioning. This is useful when a sample contains volatile 
compounds.

TIMED PAUSE - After conditioning, this step introduces a time 
delay to increase contact time between solvent and column or disk 
packing material.
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Solid Phase Extract Commands (Continued)

Column Rinse or Disk Rinse

To clear the lines before eluting, specify a volume and solvent 
(usually DI water) to be passed through the column or disk and 
specify whether the effluent is directed to the solvent or aqueous 
waste position.

For more than one solvent, repeat this selection as many times as 
necessary.

NOTES

• In contrast to a CONDITION COLUMN (or CONDITION DISK) 
step, when a COLUMN RINSE (or DISK RINSE) step is 
performed, a larger volume of air is used to push solvent 
through the entire solvent path. Therefore, it is advisable to use 
this step to rinse the column or disk with solvent after loading 
the sample onto the column or disk.

• If the manual method requires a “rinse with water” without 
allowing the water to leave the column or disk, use a 
CONDITION COLUMN (or CONDITION DISK) step rather than 
a COLUMN RINSE (or DISK RINSE) step so that a smaller air 
push is used.

• Always rinse the column or disk after sample loading to clear the 
lines of conditioning solvent before eluting, especially if the Air 
Factor is less than 1.
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Solid Phase Extract Commands (Continued)

Wash Syringe

Whenever the next step requires a solvent different from the 
previous step, perform this operation. Specify a solvent and volume 
to be used to wash the liquid handling syringe.

NOTES

• At least 2 mL of solvent is a recommended starting point.
• Alternative: Use the Autowash feature, instead. For details, see 

the description in “Setup Parameters” on page 94.
• You must insert a WASH SYRINGE step with an intermediate 

solvent when going between steps that use immiscible solvents 
(even if Autowash is being used). For example:

.

.

Rinse column with 10 mL of water into aqueous waste.

Added Wash Syringe Step --> Wash syringe with 2 mL of isopropyl 
alcohol.

Wash syringe with 2 mL of MeCl (or by Autowash).

Collect 5 mL fraction into sample tube, using MeCl.
.
.

Dry With Gas

To eliminate residual water, specify a time period (in minutes) 
during which gas passes from an external source through the SPE 
column. This is important when the elution solvent is not miscible in 
water.

NOTES

• A recommended time is 15 minutes at 10 psi (0.7 bars) using 
zero-grade nitrogen with an in-line scrubber.
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Solid Phase Extract Commands (Continued)

• This step is also used in “Creating a Method to Clean the 
Sample Lines with Solvent and DI Water” on page 68 to clean 
the sample path between batches of samples. The DRY WITH 
GAS step removes the liquid from the lines between the 
switching valve and column, leaving only water in the sample 
lines before the switching valve.

Clean Sample Path

Use this selection at the beginning of the SPE method, at the end of 
the SPE method, or in a method of its own to flush and prime the 
sample lines and pumps between sample batches. Specify a 
volume and an effluent waste position of either aqueous waste or 
solvent waste.

NOTES

• The CLEAN SAMPLE PATH step should be selected at least 
twice1. When the first CLEAN SAMPLE PATH step runs, the 
workstation pauses to place the sample lines into a beaker 
containing the elution volume. The workstation then pauses 
again to place the lines into a beaker of water when the second 
CLEAN SAMPLE PATH step runs.

• It is advisable to use CLEAN SAMPLE PATH steps in a separate 
method that is run between sample batches and at the end of a 
day. See “Creating a Method to Clean the Sample Lines with 
Solvent and DI Water” on page 68. If you prefer, use the steps 
from the method disk as the last steps in the method, instead.

WARNING

Do not use acetone as a solvent to clean the sample path because 
it is harmful to the sample pumps.

1. If an intermediate solvent is required between the elution 
solvent and water, insert a third CLEAN SAMPLE PATH step 
using this solvent between these two steps.
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Solid Phase Elute Commands

The Solid Phase Elute commands (found on the left side of the 
Setup Methods window) specify the steps that perform and follow 
sample elution. The solid phase elute menu is shown in Figure 61. 
An example method is provided in “Method Example” on page 90.

Figure 61. Solid Phase Elute Menu

NOTE

Before eluting, perform a COLUMN RINSE (or DISK RINSE) or 
DRY WITH GAS step to clear the lines.

Elute to Soak

Soak the column or disk with elution solvent or perform multiple 
elution steps with a minimal air push between them. Specify the 
solvent and volume to be introduced onto the column or disk, with 
any eluent directed to the collection container.

NOTES

• Soaking the column or disk sometimes helps in the extraction of 
analytes by increasing the contact time between solvent and 
packing material, therefore maximizing elution efficiency.

• Using a minimum amount of air when performing multiple elution 
steps prevents column or disk drying.
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Solid Phase Elute Commands (Continued)

• For a single ELUTE TO SOAK step, or for the first of multiple 
ELUTE TO SOAK steps, use a solvent volume of at least 3 mL 
to ensure that the elution solvent reaches the column or disk 
packing material. The tail end of the elution solvent is positioned 
in the flow path according to the air factor parameter - a higher 
air factor will position the end of the solvent closer to the 
column. Any subsequent elution steps can have smaller 
volumes.

• If the automated method doesn't require soaking or multiple 
elution steps, use the following ELUTE TO COLLECT step.

• An ELUTE TO SOAK step must be followed by an ELUTE TO 
COLLECT step. ELUTE TO COLLECT is ended by a larger air 
push that will push any remaining eluent into the collection 
container.

Elute to Collect

To perform a sample elution, specify a solvent and a volume to be 
passed through the column or disk with the eluent directed to the 
collection container.

NOTES

• In contrast to CONDITION COLUMN (or CONDITION DISK) and 
ELUTE TO SOAK, when ELUTE TO COLLECT is performed, a 
larger volume of air is used to push the sample through the 
entire path of liquid lines.

• Performing multiple ELUTE TO COLLECT steps is allowed as 
long as the maximum elution volume for the collection container 
is not exceeded, and the larger air push between each step is 
not a concern.

Elute to Collect Second Tube

To elute up to double the volume allowed for the collection 
container, specify a solvent and volume to be passed through the 
same column or disk, with the eluent directed to a second sample 
container. This step causes the workstation to pause for the 
operator to change collection containers.
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Solid Phase Elute Commands (Continued)

Pause

To add a pause in workstation operation, select either a timed delay 
step (in minutes) or a “pause and alert” step that signals the 
operator until the CONT button is pressed.

Examples:

PAUSE AND ALERT - Use this step to alert the operator for sample 
container introduction when the workstation is done with the column 
conditioning. This is useful when a sample contains volatile 
compounds.

TIMED PAUSE - After conditioning, this step introduces a time 
delay to increase contact time between solvent and column packing 
material.

Clean Sample Path

Use this selection at the beginning of the SPE method, at the end of 
the SPE method, or in a method of its own to flush and prime the 
sample lines and pumps between sample batches. Specify a 
volume and an effluent waste position of either aqueous waste or 
solvent waste.

NOTES

• The CLEAN SAMPLE PATH step should be selected at least 
twice1. When the first CLEAN SAMPLE PATH step runs, the 
workstation pauses to place the sample lines into a beaker 
containing the elution volume. The workstation then pauses 
again to place the lines into a beaker of water when the second 
CLEAN SAMPLE PATH step runs.

• It is advisable to use CLEAN SAMPLE PATH steps in a separate 
method that is run between sample batches and at the end of a 
day. See “Creating a Method to Clean the Sample Lines with 
Solvent and DI Water” on page 68. If you prefer, use the steps 
from the method disk as the last steps in the method, instead.

1. If an intermediate solvent is required between the elution 
solvent and water, insert a third CLEAN SAMPLE PATH step 
using this solvent between these two steps.
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Solid Phase Elute Commands (Continued)

WARNING

Do not use acetone as a solvent to clean the sample path because 
it is harmful to sample pumps. 

Rinse Sample Container

To rinse the sample container and elute to one of the three elution 
stations, specify the solvent volume that you will add to the sample 
container for rinsing and designate the elution station position.

This step causes the workstation to pause for you to add the solvent 
and swirl the sample container before it pumps the container's 
solvent through the column and into the solvent waste, aqueous 
waste, or collection containers.

Concentrate Sample

To concentrate the final eluent, specify the time in minutes for gas 
to flow into the collection containers.

This step causes the workstation to pause for you to replace the 
SPE columns with empty columns before gas flows into the 
collection containers.
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Solid Phase Elute Commands (Continued)

Wash Syringe

Whenever the next step requires a solvent different from the 
previous step, perform this operation. Specify a solvent and volume 
to wash the liquid handling syringe.

NOTES

• At least 2 mL of solvent is a recommended starting point.
• Alternative: Use the Autowash feature, instead. For details, see 

the description in “Setup Parameters” on page 94.
• You must insert a WASH SYRINGE step with an intermediate 

solvent when going between steps that use immiscible solvents 
(even if Autowash is being used). For example:

.

.
Rinse column with 10 mL of water into aqueous waste

Added Wash Syringe Step --> Wash syringe with 2 mL of isopropyl 
alcohol.

Wash syringe with 2 mL of MeCl (or by Autowash).

Collect 5 mL fraction into sample tube, using MeCl.

.

.
End Method

This selection completes the entry of your method steps. This step 
is required for all methods. 
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Method Example
To give you a better idea of how to transfer a method into an 
AutoTrace method, a method example follows.

Manual Steps

The steps summarized below have been taken from a nitrogenous 
herbicide method as a demonstration of how to transfer a method to 
the AutoTrace Workstation.

1 Condition the SPE cartridge with two 10 mL aliquots of 
methanol.

2 Add 10 mL of reagent water to the SPE cartridge.

3 Pass 1 liter of prepared water sample through the SPE 
cartridge.

4 Wash the sample reservoir with 10 mL of reagent water and 
pass through the SPE cartridge to waste.

5 Dry the SPE cartridge under vacuum for 10 minutes.

6 Elute the SPE cartridge with 5 mL of ethyl acetate to collect.

7 Elute the SPE cartridge with 5 mL of methylene chloride to 
collect.
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AutoTrace Method Example

The following AutoTrace method printout example shows how to 
automate the manual steps listed on the previous page.

Dionex AutoTrace Extraction Workstation 2.11.2

AutoTrace Extraction Method: Nitrogenous Herbicide Method

Step 1: Process six samples using the 
following method

Step 2:a

a. To eliminate all traces of the previous solvent before 
using the next solvent.

Wash syringe with 2 mL MeOH

Step 3: Condition column with 10 mL of 
MeOH into SOLVENT WASTE 

1st part of manual step 
#1

Step 4: Condition column with 10 mL of 
MeOH into SOLVENT WASTE 

2nd part of manual 
step #1

Step 5:a Wash syringe with 2 mL of WATER

Step 6: Condition column with 10 mL of 
WATER into AQUEOUS WASTE

manual step #2

Step 7: Load 1000 mL of sample onto column manual step #3

Step 8: Rinse column with 10 mL of WATER 
into AQUEOUS WASTE

manual step #4

Step 9: Dry column with gas for 10 minutes manual step #5

Step 10:a Wash syringe with 2 mL of EtOAc

Step 11: Collect 5 mL fraction into sample tube 
using EtOAc

manual step #6

Step 12:a Wash syringe with 2 mL of MeCl

Step 13: Collect 5 mL fraction into sample tube 
using MeCl

manual step #7

Step 14: END
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AutoTrace Method Example (continued)

SETUP PARAMETERS

AutoTrace Extraction Workstation

NAME SOLVENTS

FLOW RATES SPE PARAMETERS

Cond Flow: 10.0 mL Push Delay: 5 sec.

Load Flow: 10.0 mL Air Factor: 1.0

Rinse Flow: 10.0 mL Autowash Vol:a

a. Specifying 2 mL for the Autowash Volume allows 
the elimination of steps 2, 5, 10, and 12 in the 
method. 

0.00 mL

Elute Flow: 2.0 mL

Cond Air Push: 10.0 mL WORKSTATION PARAMETERS

Rinse Air Push: 10.0 mL

Elute Air Push: 10.0 mL Max Elution Vol: 12.0 mL

Exhaust Fan on: Y Y=Yes, 
N=No

Beeper On: Y Y=Yes, 
N=No

Solvent 1: MeOHa

a. The corresponding solvent names are specified. 

Solvent 2: WATERa

Solvent 3: EtOAca

Solvent 4: MeCla

Solvent 5: not useda
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Application Tips
Once the method is written, it may require some fine-tuning to 
optimize sample recovery and/or sample throughput. The need for 
changes may be evident when first running the method, or when 
examining the recovery data from the sample run. If the recovery 
data looks good, test higher flow rates, shorter times, etc. to 
achieve a higher sample throughput.

Optimizing

When making changes to optimize the method, make them one at a 
time to evaluate the effect of the change.

The next few pages provide recovery data, setup parameter, and 
method step considerations for optimizing the automated method.

Sample Recovery

Table 7 describes three areas that can cause unacceptable 
recovery and should be investigated when optimizing sample 
recovery.

NOTE

Sometimes sample recovery is optimized at the expense of sample 
throughput (e.g., slower flow rates and longer times).

Table 7. Sample Recovery Optimization

Breakthrougha

a. Can be determined by collecting aqueous waste and 
manually analyzing it for target compounds.

Elutionb

b. Sample retention - still on column or disk.

Internal Lossc

c. Sample adsorption.

Conditioning steps Solvent type Sample path
Conditioning flow and 
air push rates

Solvent miscibility Sample container

Solvent type Solvent volume
Solvent volume Elution flow and air 

push rates
Loading rate
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Setup Parameters

Table 8 lists some considerations for setting the parameters in the 
automated method.

Table 8. Setup Parameters

If... Then...
you need to improve 
recovery

decrease the flow rate(s)

you need to improve 
throughput

increase the flow rate(s)

the liquid handling syringe 
stalls

decrease the flow rate(s)

you are using viscous liquids adjust the Push Delay
you need to decrease the 
amount of air between 
multiple conditioning steps

reduce the Air Factora

a. When using an Air Factor less than 1, always perform a 
COLUMN RINSE (or DISK RINSE) after loading the 
sample.

you need syringe washing to 
appear in your method 
printout for auditing purposes

disable Autowash and use the 
WASH SYRINGE method steps 
where needed
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Method Steps

Table 9 lists some considerations for designating the steps in the 
automated method.
.

Table 9. Method Step Considerations 

If... Then...
the sample contains volatile 
compounds

introduce samples to the workstation only when 
ready for them by placing a PAUSE AND 
ALERT step between conditioning and loading 
steps

the manual method requires a 
“rinse with water” step without 
allowing the water to leave the 
column or disk

use a CONDITION COLUMN (or CONDITION 
DISK) step rather than a COLUMN RINSE (or 
DISK RINSE) step, so that a smaller air push is 
used

you need an extended contact 
time between solvent and packing 
material

introduce a TIMED PAUSE step

the sample contains a large 
amount of solids

add 5% to 7% to your volume entry for the 
LOAD SAMPLE step

you are going between immiscible 
solvents in the method

perform a WASH SYRINGE step with an 
intermediate solvent before performing the next 
step (even if Autowash is being used)

you need syringe washing to 
appear in your method printout for 
auditing purposes

disable Autowash and use WASH SYRINGE 
method steps where needed

you are running with the Air 
Factor parameter set to less than 
one

you must perform a COLUMN RINSE (or DISK 
RINSE) step between sample loading and 
elution

the elution solvent is immiscible in 
water

eliminate channeling by performing a DRY 
WITH GAS step to remove all water from the 
column

you are not drying the column or 
disk after loading sample

you must perform a COLUMN RINSE (or DISK 
RINSE) step before elution

there is water in your extract increase the pressure and/or time of the DRY 
WITH GAS step

the elution solvent is not reaching 
the packing material in the first 
ELUTE TO SOAK step

use a volume of 3 mL or greater in the elution 
step

you need to increase the contact 
time between solvent and packing 
material for extraction of analytes

use an ELUTE TO SOAK step before ELUTE 
TO COLLECT
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you need to keep the amount of 
air introduced between multiple 
elution steps to a minimum

use an ELUTE TO SOAK step before ELUTE 
TO COLLECT

you need to collect more than the 
maximum elution volume of your 
collection container

use an ELUTE TO COLLECT, 2nd TUBE step to 
double the collection volume

you need to improve throughput decrease times wherever possible
you need to improve recovery refer to the Sample Recovery table
you need to run a solvent through 
the sample path (from sinkers, 
through the sample lines, sample 
pumps, switching valves, and 
columns, to a designated 
collection position)

For example, in a conditioning 
step requiring 40 mL of water, 
rather than using four 
CONDITION COLUMN (or 
CONDITION DISK) steps of 
10 mL, you can save time by 
using a single 40 mL CLEAN 
SAMPLE PATH step to aqueous 
waste. Follow with a PAUSE AND 
ALERT step for moving the lines 
from the water container to the 
sample containers.

use a CLEAN SAMPLE PATH step to designate 
either of the waste positions

or

use a RINSE SAMPLE CONTAINER step to 
designate either of the waste positions or the 
collection container position

Table 9. Method Step Considerations (Continued)

If... Then...
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Operation
This section describes the steps involved in operating the 
AutoTrace SPE Workstation. The information is divided into three 
major topics:
• Preparing the AutoTrace SPE Workstation for operation
• Running the AutoTrace SPE method
• What to do after running the method

Also see the “Method Development Checklist” on page 111 and the 
“Daily Operation Checklist” on page 112.

Preparing the AutoTrace SPE Workstation
To prepare the AutoTrace SPE Workstation for operation:

1 Turn on the workstation, using the power switch located on the 
right of the unit, toward the middle. After power-up, the work- 
station goes through a brief initialization.

NOTE

We recommend that you leave the workstation running unless it will 
not be used for an extended period of time.

2 To perform a DRY WITH GAS or CONCENTRATE SAMPLE 
method step, turn on the gas supply. Set the pressure no 
greater than 100 psi (6.9 bars). The gas supply should have 
sufficient reserve for the sample run.

3 Adjust the workstation's output gas pressure to the proper 
setting for running the method. A recommended operating 
setting is 10 psi (0.7 bars). Adjust the gas pressure, using the 
regulator knob provided on the left side of the unit.

4 Check that the solvent reservoirs are full and the tubing is fully 
submerged in reservoirs (use the tubing weights provided).

5 Check that all waste containers (side port, elution station 
solvent, and elution station aqueous waste) are empty.

6 Download the Purge Solvent method or run your customized 
purge method (see “Customizing a Method to Purge Less than 
Five Solvent Lines” on page 67). The method draws a sufficient 
amount of solvent from each port to prime the liquid lines.
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Preparing the AutoTrace SPE Workstation 
(Continued)

7 Place a collection container in each elution rack position. Install 
the elution rack onto the two pins on the front of the elution 
station. 

NOTE

The rack is symmetrical and can be positioned either way.

8 Optional Step: When using the AutoTrace Cartridge version, 
manually rinse the columns with MeCl or water. This prevents 
leakage around the column holder O-ring due to the presence of 
packing debris on the inside walls of the SPE column.

9 For the AutoTrace Cartridge version: Place columns in each 
holder to be used by sliding a column upward onto the bottom of 
the column holder's plunger. Push down on the lever until the 
assembly “clicks” into place and the holder's LED comes on. 
See Figure 62.

For the AutoTrace Disk version: Place disks in each holder to 
be used by opening the disk holder (by unscrewing the locking 
collar), squeezing the clip and moving it up toward the lever, and 
sliding the holder up. Push down on the lever until the assembly 
“clicks” into place and the holder's LED comes on. See 
Figure 63.
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Preparing the AutoTrace SPE Workstation 
(Continued)

Figure 62. Column Holder Front View

Figure 63. Disk Holder Front View

LED

Lever
Plunger

Column

LED

Lever

Clip

Locking Collar
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Preparing the AutoTrace SPE Workstation 
(Continued)

10 Place a sample container in each rack position to be used and 
insert the sample line with tubing weight into the appropriate 
container. Each sample line and each rack position is numbered 
to correspond to the numbered positions on the right side of the 
AutoTrace Workstation, as shown in Figure 64.

Figure 64.  AutoTrace Workstation Right Side and Sample Rack
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Running an AutoTrace SPE Method
The front panel controls are displayed in Figure 65 and their 
functions are described in Table 10.

Figure 65. Front Panel Controls

There are two ways in which you can run an AutoTrace method:
• Pressing the LOAD button when the unit is turned on.
• Pressing the CONT button for subsequent runs of a previously 

loaded method.

LOAD Button Operation

To refresh all files on the unit’s CPU board and load a method at 
power-up, press the LOAD button.

This initiates an “automatic startup sequence” that loads the 
operating software, “initializes” the workstation, and begins running 
the method.

Table 10. Front Panel Controls

# Part Function
1 LOAD button Downloads software and a method when 

held down during power-up.
2 PAUSE button Stops the workstation after it completes the 

step it is performing.
3 CONT button Continues operation after using the PAUSE 

button, responding to the ERROR light, or 
after manual intervention. Also used to start 
a method or download a method.

1 2 3

READY RUN ERROR

LOAD PAUSE CONT
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LOAD Button Operation (Continued)

The workstation's automatic startup sequence that is initiated after 
pressing the LOAD button causes:
• The operating files and method to be loaded
• The workstation to beep and the front panel display to remind 

you to check for columns and tubes, to check the waste 
container, and prompt you to press CONT to acknowledge the 
reminders and continue

• The RUN light to come on
• The valves to click
• The sample processing to begin

CONT Button Operation

To start processing a new batch of samples after all samples from 
the prior run have been processed, press the CONT button twice 
slowly.

This begins running the method without loading the operating 
system first.

NOTE

Use caution when using the CONT button to start a method. If all 
steps haven't been run (the PAUSE button has been pressed), 
pressing the CONT button continues operation where it was before 
processing was interrupted - not at step #1.

Front Panel Display During Operation

While the method runs, the front panel reports each step as it is 
performed and the time left for the operation, if applicable. For 
example, while a sample is being loaded (pumped) onto the 
column, the front panel displays:

LOADING SAMPLES
ONTO COLUMNS

@ 10 MLS/MIN
5 MINUTES LEFT



Operation 103

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Front Panel Display During Operation (Continued)

NOTE

The Disk version of the AutoTrace Workstation will display “Disk” 
instead of “Column” on the front panel.

The display also reports when manual intervention is required and 
when the sample run is finished.

Front Panel Display Messages

Some method steps cause the workstation to pause operation and 
wait for manual intervention. When this happens, the workstation 
beeps (if the Beeper On parameter is set to YES) and the front 
panel displays a message prompting that an action is required. 
Table 11 lists the front panel messages.

NOTE

The Disk version of the AutoTrace Workstation will display “Disk” 
instead of “Column” in the messages.

Table 11. Front Panel Messages 

Method Step Front Panel Display
Rinse Sample 
Container

RINSE SAMPLE
CONTAINER WITH
xx ML
PRESS CONT TO RESUME

Elute to Collect, 
2nd Tube

SECOND ELUTION STEP
REPLACE TUBES
WITH NEW TUBES
PRESS CONT TO RESUME

Concentrate 
Sample

CONCENTRATION STEP
PLACE EMPTY COLUMNS
IN THE HOLDERS
PRESS CONT TO RESUME

Clean Sample 
Path

TO CLEAN SAMPLE PATH
PLACE SAMPLE INPUT
LINES INTO A BREAKER
PRESS CONT TO RESUME
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When you complete the manual steps, press the CONT button so 
the workstation can proceed running the method.

Pausing Operation

To pause the method at any time, press the PAUSE button. The 
workstation stops and pauses after it completes the operation it was 
performing when the PAUSE button was pressed.

Continuing Operation

To resume the method from where it paused, press the CONT 
button.

Aborting

If you do not wish to continue workstation operation, abort the 
operation as follows:

1 Turn the power off.

2 Release the column or disk holders from the fully down position 
by squeezing the holder's lever and clipping them together, as 
shown in Figure 66.

Figure 66. Column Holder - Side View

Pause and Alert SYSTEM PAUSED
PRESS CONT TO RESUME

Table 11. Front Panel Messages (Continued)

Method Step Front Panel Display

Lever
Clip
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Aborting (Continued)

WARNING

Never leave the column or disk holders in the down position without 
the columns or disks in place because this can deform the O-ring. 

3 Turn the power on.

Columns Leaking

If liquid is leaking through the O-ring of the column holder, fix the 
leak as follows:

1 Interrupt operation for that sample by releasing the column 
holder (refer to the “Aborting” method). This will turn off the 
sample pump.

2 Create a seal around the O-ring by using an up and down 
motion to lift up and reseat the holder.

3 The workstation will resume operation on that sample when the 
lever is pushed back into the down position and the holder's 
LED comes on.

NOTE

A small loss of sample will result when step #3 is performed. 

Observe Operation

While the workstation runs the method for the first few times, 
observe operation and make note of any procedural changes that 
are desired (for example, changing flow rates or volumes). The 
need for changes may not be evident until the examination of the 
recovery data for the sample run. If necessary, refer to “Application 
Tips” on page 93.
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Detecting Errors

The AutoTrace operating software detects hardware and system 
errors. Hardware errors pause operation1, write a message to the 
display, and light the ERROR light. System errors pause operation 
and cause the READY light to flash.

Error Light Response

If the ERROR light comes on, check the front panel display for a 
message describing the error. Correct the error and resume 
operation by pressing the CONT button.

Flashing Ready Light Response

In the uncommon event of a system error (flashing READY light), 
follow the steps below:

1 Turn the power off and wait 15 seconds.

2 Press and hold the LOAD button while turning the power back 
on, and then release the LOAD button.

3 If the condition persists, the file may be bad. Download the 
method again.

4 If the condition still persists, contact Dionex Technical Support 
(see “Contact Us” on page 3).

Sample Run Completion

If the Beeper On parameter is set to YES, the workstation beeps 
every 60 seconds to alert you to the end of the sample run.

1.Exception: If a column or disk gets clogged and the sample 
pump stalls, the workstation stops processing that sample but 
continues processing all others. An error message (THESE DISK 
ARE BAD X X X X X X) is displayed on the screen, and the ERROR 
light comes on at the end of the sample run.

To... You...
Silence the alarm Press the CONT or PAUSE button.
Run the same method on 
another batch of samples

Press the CONT button after 
performing the necessary 
preparatory steps.
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After Running the Method
After running your method:
• Make any necessary procedural changes (during method 

development)
• Test the changes
• Remove the used columns or disks
• Prepare to run the next batch of samples
• Clean up, if done for the day

Determine Required Changes

Based on the recovery data and operation observations during 
method development, changes may be needed in the AutoTrace 
SPE method. The Elute Flow and Load Flow parameters are usually 
the most critical settings. Refer to the method development guide 
published by the manufacturer of your SPE columns or disks for 
additional assistance. Also, use the AutoTrace online Help and refer 
to “Application Tips” on page 93.

NOTE

When making changes to optimize the method, make them one at a 
time to evaluate the effect of the change.

Make the Necessary Changes

To make changes:

1 Start the AutoTrace software.

2 From the AutoTrace main menu, choose Methods.

3 Press the LOAD button.

4 Double-click the desired method from the list.

5 Close the Find Method window.

6 Edit the method.

7 After making changes to the method, choose Save Method.

Test the Changes

To test the changes, run the method to evaluate the outcome of the 
changes.



Operation 108

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Removing Used Columns

Remove the used columns (see Figure 67) by squeezing the 
holder's lever and clip together to release the column from the 
holder.

Figure 67. Column Holder - Side View

WARNING

Never leave the column holders in the down position without the 
columns in place because this can deform the O-ring. 

Removing Used Disks

Remove the used disks by unscrewing the locking collar (see 
Figure 68), squeezing the clip and moving it up toward the lever, 
and sliding the holder up.

Lever
Clip
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Removing Used Disks (Continued)

Figure 68. Disk Holder - Side View

Next Sample Batch Preparation

Unless the last steps of the method were CLEAN SAMPLE PATH 
steps, you need to clean the sample lines between batches of 
samples.

1 Place an empty column or disk in each holder and make sure 
each holder is in the fully down position, with the holder LED on.

2 Download the Clean Sample Path method that was saved to the 
database.

3 When the workstation pauses the first time, insert the sample 
lines into a clean container filled with a solvent.

Lever

Clip

Locking Collar
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Next Sample Batch Preparation (Continued)

WARNING

Do not use acetone as a solvent to clean the sample path because 
it is harmful to the sample pumps.

4 If the solvent used in step 3 is immiscible in water: When the 
workstation pauses the second time, remove the sample lines 
and insert them into a clean container filled with an intermediate 
solvent. Press the CONT button when ready. Otherwise, skip to 
step 5.

5 When the workstation pauses the last time, remove the sample 
lines and insert them into a clean container filled with deionized 
water. Press the CONT button when ready.

Daily Cleanup

When done using the workstation for the day:
• Empty the waste reservoirs
• Flush the solvent lines
• Flush the sample lines

Flushing the Solvent Lines

When using samples that tend to crystallize, or corrosive solvents 
that could attack valves or other AutoTrace parts over time, flush 
the solvent and sample lines with water or an inert, soluble solution 
whenever the workstation will not be processing samples. To flush 
the solvent lines:

1 Fill the solvent reservoirs with the solvent of choice for flushing 
and fully submerge the tubing.

2 Swirl the solvent in the containers to rinse the outside surface of 
the tubing and weights.

3 Download the method (created in either “Purging the Solvent 
Lines Utility” on page 66 or “Customizing a Method to Purge 
Less than Five Solvent Lines” on page 67) and press the CONT 
button twice slowly.

4 When the workstation pauses, press the CONT button.
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Flushing the Sample Lines

To flush the sample lines, refer to “Next Sample Batch Preparation” 
on page 109. 

Method Development Checklist
Specify Your Method

Run the AutoTrace software.
Specify the parameter and solvent information.
Write the method.
Print and save the method.

Prepare the Workstation

Turn on the workstation.
Turn on and check the gas supply and set gauge (if applicable).
Check the solvent reservoirs.
Check/empty the waste containers.
Purge the solvent lines.
Load the elution rack.
(Optional) Clean the columns or disks.
Load the SPE columns or disks.
Load the sample container rack.

Run the Method

Load the method.
Observe operation.
Press the CONT or PAUSE button to silence alarm for end-of-
run.

After Running the Method

Based on recovery data and observations during operation, 
make any necessary procedural changes, using the METHODS 
program option.
Remove the used columns or disks.
Prepare to run the next batch of samples by cleaning the sample 
lines.
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If done for the day, clean up by emptying the waste reservoirs 
and flushing the solvent and sample lines.

Daily Operation Checklist
Prepare the Workstation

Turn on the workstation.
Turn on and check the gas supply and set gauge (if applicable).
Check the solvent reservoirs.
Check/empty the waste containers.
Purge the solvent lines.
Load the elution rack.
(Optional) Clean the columns or disks.
Load the SPE columns or disks.
Load the sample container rack.

Run Your Method

Load the method or press the CONT button to rerun a method 
on a different batch of samples.
Intervene as required.
Press the CONT or PAUSE button to silence alarm for end-of-
run.

After Running the Method

Remove the used columns or disks.
Prepare to run the next batch of samples by cleaning the sample 
lines.
If done for the day, clean up by emptying the waste reservoirs 
and flushing the solvent and sample lines.
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Diagnose Problems
This section of the manual describes how to diagnose AutoTrace 
Workstation problems. This information is divided into:
• Error Messages
• AutoTrace Diagnostics
• Troubleshooting Guide

If you have any additional questions about diagnosing workstation 
problems, contact Dionex Technical Support (see “Contact Us” on 
page 3). When calling, please have the information recorded in the 
front of the manual ready for the Technical Support Representative.

Error Messages
Hardware errors pause operation, write a message to the front 
panel display, and light the ERROR LED. If the ERROR LED comes 
on, look at the front panel display for a message describing the 
error. After correcting the error, resume operation by pressing the 
CONT button.

Descriptions follow of the error messages displayed on the 
AutoTrace Workstation’s front panel display.

Front Panel Error Message

An example error message displayed on the front panel is shown 
below. Messages that appear for method steps and require manual 
intervention are described in “Front Panel Display Messages” on 
page 103.

Message Action

METHOD FILE DID
NOT APPEND
CORRECT THE 
PROBLEM
PRESS CONT TO 
RESUME

Download the method from the PC.

THESE DISK ARE BAD
X X X X X X

Inspect the columns or disks for 
plugging. Inspect sample pumps for 
correct operation.
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AutoTrace Diagnostics
The Diagnostics menu option in the AutoTrace software contains 
diagnostic routines that can be downloaded and run on the 
workstation. If there is a need to test, adjust, or replace AutoTrace 
components, and an AutoTrace diagnostic method needs to be run, 
refer to the “Downloading and Running an AutoTrace Diagnostic 
Method” on page 115.

Diagnostic List

The tables below list when various diagnostics are useful. Consult 
the Diagnostics online Help windows for the current selections and 
most up-to-date information and recommendations on how to save, 
run, repeat, and advance when using the diagnostic facility.

NOTE

You must read all online Help information before running any 
AutoTrace diagnostic.

Table 12. Diagnostic List 

When you want to... Run the diagnostic...
Syringes Check the integrity of 

the liquid handling 
syringe drive 
mechanism

Adjust Liquid Syringe

Check the integrity of 
the air syringe drive 
mechanism

Adjust Air Syringe

Valves Confirm the positioning 
integrity of the 12-port 
valve

Check 12-port valve

WARNING

Do not run the valves diagnostic if the solvent lines 
have not yet been purged.
Prime or drain the liquid 
linesa

Purge Solvents
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Downloading and Running an AutoTrace Diagnostic Method

To download a diagnostic and run it on your workstation:

1 From the AutoTrace main menu, choose Diagnostics.

2 Select the appropriate diagnostic from the listing.

NOTE

Press the F1 key to access online Help and get detailed information 
about the diagnostic selected.

3 The diagnostic is automatically downloaded to the AutoTrace 
workstation.

Initialization Diagnose the reason for 
an AutoTrace failing to 
initialize property

Initialization

a. In most cases, writing your own purge method does a 
better job of purging the lines. A customized purge routine 
can save time and conserve solvent.

Table 12. Diagnostic List (Continued)

When you want to... Run the diagnostic...

When you want to... Perform this action...
Run the diagnostic Press the CONT button twice... 

slowly
(2 seconds between presses)

Repeat the diagnostic Press the CONT button twice... 
rapidly

Stop continuous
routines

Press the PAUSE buttona

a. To run a subsequent method or diagnostic, select another 
diagnostic from the drop-down menu, and then press 
CONT twice slowly.
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Troubleshooting
This section provides troubleshooting information for the AutoTrace 
SPE Workstation. The section is divided into the following topics:
• “General Operation Troubleshooting” on page 117
• “ERROR Light Troubleshooting” on page 118
• “Computer Troubleshooting” on page 118
• “Liquid Handling Troubleshooting” on page 119
• “Solid Phase Extraction Troubleshooting” on page 122

Refer to the appropriate section and locate the symptom in the left-
hand column that describes the problem. Then refer to the probable 
cause and solution listed to the right of the symptom.

Symptoms experienced may not indicate a problem with the 
workstation; they may be related to a parameter setting or method 
step selection. Refer to “Application Tips” on page 93.

Replace Parts

If the solution is to replace a part, refer to “Ordering Supplies” on 
page 163. The AutoTrace Replacement Kits include detailed 
instructions on part replacement. 

WARNING

Unplug the AC power from the workstation before servicing the unit. 

Additional Assistance

If after following this manual you need additional help, contact 
Dionex Technical Support (see “Contact Us” on page 3). When 
calling, please have the information recorded in the front of the 
manual ready for the Technical Support Representative.
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General Operation Troubleshooting

Table 13. General Operation 

Symptom Probable Cause Solution
1. READY light not ON. 1a. Power switch is OFF. 1a. Turn power switch on left 

side of workstation ON.
1b. AC power cord is 
unplugged.

1b. Connect the AC power 
cord.

1c. Fuse is blown. 1c. Replace the fuse. Refer to 
“Replacing Fuses” on 
page 137.

1d. No voltage at power 
outlet.

1d. Check the outlet voltage 
with another component, such 
as a desk lamp.

2. READY light 
flashing.

2a. Internal CPU error 
condition (system error).

2a. Turn AC power OFF. Wait 
15 seconds. Press the LOAD 
button while turning AC power 
on, and then release the 
LOAD button.

2b. CPU is bad. 2b. Replace the CPU. Refer 
to “Ordering Supplies” on 
page 163.

3. When AC power is 
turned on, syringe 
motors make a 
chattering sound (with 
syringes fully emptied).

3. Limit switch on the 
syringe drive needs 
adjustment.

3. Adjust the syringe(s) 
according to the program's 
syringe diagnostics or as 
described in “Maintenance” 
on page 126.

4. RUN light fails to 
turn on after the LOAD 
button is pressed or the 
method does not run.

4a. Files missing from 
download.

4a. Run the program’s 
Initialization diagnostic, 
referring to the Help screens. 
If the problem continues, 
contact Dionex Technical 
Support.

4b. Loose connection on 
the control board.

4b. Run the “Benchmark Test 
Utility” on page 141 and 
contact Dionex Technical 
Support.

4c. Column or disk holder 
not fully down – holder's 
green LED is Off.

4c. Push down on the holder 
lever until it “clicks” and the 
holder's green LED comes 
On. Press the LOAD button.
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ERROR Light Troubleshooting

Computer Troubleshooting

Table 14. Error Light

Symptom Probable Cause Solution
The ERROR light 
comes on during, or at 
the end of, a method.

Hardware error. Error message displays. 
Contact Dionex Technical 
Support.

Table 15. Computer 

Symptom Probable Cause Solution
Unable to download a 
method.

Communication error. Check the communication 
cable and the COM port 
setting.
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Liquid Handling Troubleshooting

Table 16. Liquid Handling 

Symptom Probable Cause Solution
1. Syringe makes a 
clicking sound while 
moving.

1a. Syringe speed is too 
fast.

1a. Adjust the flow rates.

1b. Syringe not securely 
mounted.

1b. Check the syringe 
mounting.

1c. Defective syringe. 1c. Replace the syringe 
according to “Replacing and 
Adjusting the Liquid Handling 
Syringe” on page 128. Refer 
to “Ordering Supplies” on 
page 163 for ordering 
information.

1d. Fluid path blocked at 
valve, SPE column, or 
tubing.

1d. Inspect the fluid path and 
correct the problem.

2. Incorrect solvent 
dispensed.

2. Solvent lines placed in 
wrong reservoirs.

2. Reinsert solvent lines into 
appropriate reservoirs and 
purge lines.

3. Syringe stalls 3a. Flow rate is too high. 3a. Adjust the flow rate. 
3b. Bad SPE column. 3b. Replace the SPE 

column.
3c. 12-port valve problem. 3c. Run the CHECK 12- 

PORT VALVE diagnostic. 
Refer to “Diagnostics Menu” 
on page 61 and the online 
Help. Do not run the 
diagnostic until all solvent 
lines have been purged. If 
the problem continues, 
contact Dionex Technical 
Support.

4. Valves leak. 4a. Flow rate is too high. 4a. Adjust the flow rate. 
4b. Valve fitting loose. 4b. Tighten the valve fitting.
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5. Liquid volumes 
delivered are 
incorrect.

5a. Flow rates are too high, 
causing gas bubbles to form.

5a. Reduce the flow rates.

5b. Restricted or leaking 
solvent inlet tubing.

5b. Inspect for kinks or 
cracks in the tubing. If 
necessary, replace the 
tubing. Refer to “Ordering 
Supplies” on page 163 for 
ordering information.

5c. Solvent outgassing. 5c. Degas or sparge 
reagents with helium before 
use.

5d. Loose valve fittings or 
loose coaxial fitting.

5d. Make sure all fittings are 
finger tight.

5e. Defective valve fittings. 5e. Contact DionexTechnical 
Support.

5f. Syringe leaking. 5f. Run the Syringe 
Diagnostic. Refer to 
“Diagnostics Menu” on 
page 61 and the online Help. 
If necessary, replace the 
syringe. Refer to “Ordering 
Supplies” on page 163 for 
ordering information.

5g. 12-port valve is partially 
blocked or out of alignment.

5g. Run the CHECK 12- 
PORT VALVE diagnostic. 
Refer to “Diagnostics Menu” 
on page 61 and the online 
Help. Do not run the 
diagnostic until all solvent 
lines have been purged. If 
the problem continues, 
contact Dionex Technical 
Support.

5h. Steps using immiscible 
solvents.

5h. Wash the syringe with 
intermediate solvent 
between steps.

Table 16. Liquid Handling (Continued)

Symptom Probable Cause Solution
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6. Liquid buildup in 
10 mL air syringe.

6a. Excessive pressure built 
up in unit due to blocked 
line, or excessive solids in 
column.

6a. Inspect and correct the 
problem.

6b. Syringe speed too fast. 6b. Adjust the flow rates.
6c. Air valve leaking. 6c. The valve needs 

replacement. Contact Dionex 
Technical Support.

7. Incorrect volume 
removed from the 
sample container. 

7a. Samples with large 
amounts of suspended 
solids.

7a. Increase the sample 
volume specified in the 
LOAD SAMPLE step (refer to 
“Solid Phase Extract 
Commands” on page 80) by 
5% to 7%. For example, 
specify 1050 mL instead of 
1000 mL. 

7b. Sample pump is out of 
calibration.

7b. Perform CLEAN 
SAMPLE PATH with 
deionized water, and then 
run the CALIBRATE PUMP 
utility as described in 
“Calibrating Sample Pumps” 
on page 139.

7c. Fittings are loose at the 
sample pump.

7c. Tighten the fittings.

8. Uneven volumes in 
elution containers. For 
example, 10 mL is 
expected and one 
container has 8 mL, 
while the other has 
12 mL.

8. Loose fitting at 12-port 
valve or switching valve.

8. Check the tightness of the 
fittings.

Table 16. Liquid Handling (Continued)

Symptom Probable Cause Solution
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Solid Phase Extraction Troubleshooting

Table 17. Solid Phase Extraction 

Symptom Probable Cause Solution
1. LED on column or 
disk holder fails to 
light.

1a. Column or disk deformed 
or size incorrect.

1a. Discard and replace the 
column or disk.

1b. Defective column or disk 
holder.

1b. Contact Dionex Technical 
Support.

1c. The column or disk is 
missing.

1c. Install the column or disk.

2. Leakage around the 
O-ring of the column 
or disk holder.

2a. Packing material debris 
may exist on the inside walls 
of the column or disk, 
causing a poor seal. 

2a. Clean out the columns or 
disks before use. Refer to 
Cleaning the SPE Columns 
in “Preparing the AutoTrace 
SPE Workstation” on 
page 97.

2b. Dirty O-ring. 2b. Clean the O-ring with a 
wipe and solvent.

2c. Cracked O-ring. 2c. Replace the O-ring. 
When replacing the O-ring 
for glass column units, 
replace the whole plunger 
assembly. Refer to “Ordering 
Supplies” on page 163.

3. Low recovery of 
volatile compounds.

3a. Sample evaporates 
while column or disk 
conditioning occurs.

3a. Use a PAUSE AND 
ALERT step to introduce 
sample when needed by the 
method.

3b. The gas pressure is set 
too high.

3b. Decrease the gas 
pressure. 

4. Low recovery. 4. Varies. 4. Refer to the list in “Sample 
Recovery Optimization” on 
page 93.
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5. Water coming off 
with eluent.

5a. Method is missing a step 
to clear the lines.

5a. Add a COLUMN RINSE 
(or DISK RINSE) or DRY 
WITH GAS step before 
elution.

5b. The gas pressure is too 
low.

5b. Increase the gas 
pressure.

5c. The drying time is too 
short.

5c. Increase the dry time 
specified in the DRY WITH 
GAS step.

5d. None of the above. 5d. Run eluent through a 
drying column or disk before 
analysis.

6. Cross-
contamination.

6. The sample path was not 
cleaned between sample 
passes.

6. Use “Creating a Method to 
Clean the Sample Lines with 
Solvent and DI Water” on 
page 68 between each batch 
of samples. 

7. Incorrect volume 
removed from the 
sample container. 

7a. Samples with large 
amounts of suspended 
solids.

7a. Increase the sample 
volume specified in the 
LOAD SAMPLE step (refer to 
“Solid Phase Extract 
Commands” on page 80) by 
5% to 7%. For example, 
specify 1050 mL instead of 
1000 mL. 

7b. Sample pump is out of 
calibration.

7b. Perform CLEAN 
SAMPLE PATH with 
deionized water (refer to 
“Creating a Method to Clean 
the Sample Lines with 
Solvent and DI Water” on 
page 68), and then run the 
CALIBRATE PUMP utility as 
described in “Calibrating 
Sample Pumps” on 
page 139.

8. Sample pump fails 
to start.

8. Bad electronics board or 
pump.

8. Contact Dionex Technical 
Support to determine the 
faulty part and replace. See 
“Ordering Supplies” on 
page 163. 

Table 17. Solid Phase Extraction (Continued)

Symptom Probable Cause Solution
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9. Nothing comes out 
of an elution manifold 
nozzle.

9. Clogged nozzle. 9. Clean the nozzle with a 
fine piece of wire. If the 
problem persists, replace the 
manifold. See “Ordering 
Supplies” on page 163. 

10. Elution station 
does not move into 
the correct position.

10. Bad stepper motor or 
loose connection on control 
board.

10. Run the “Benchmark Test 
Utility” on page 141 and 
contact Dionex Technical 
Support.

Table 17. Solid Phase Extraction (Continued)

Symptom Probable Cause Solution
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Error Codes
This section describes the error codes that may appear when 
downloading either methods or utility procedures.

Error Code Description Action
-1073741510 File Download Terminated Repeat the download and let all the 

download windows close 
automatically.

4096 INI File Not Found Close the software and verify that the 
AT.INI file exists in the directory.

4100 COM port not set in INI file Close the software and verify that the 
COM port is set in the AT.INI file.

8192 File Download Completed N/A
16385 Port Control Error Check COM port communications.
16896 No Response time-out Check the connection with the 

AutoTrace and verify that the correct 
COM port is set in the AT.INI file.
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Maintenance
This section of the manual describes how to maintain, adjust, and 
replace components in the AutoTrace SPE Workstation, including:
• Routine Maintenance
• Replacing and Adjusting the Liquid Handling Syringe
• Replacing and Adjusting the Air Syringe
• Replacing Fuses
• Calibrating Sample Pumps
• Running the Benchmark Test

Establish an appropriate schedule for performing routine 
maintenance according to how often the workstation is run. Perform 
any of the other methods indicated by the solution steps in 
“Troubleshooting” on page 116.

In order to test, adjust, or replace components other than what is 
covered in this section, run the diagnostics. Information on running 
the diagnostics can be found in “Diagnose Problems” on page 113. 
Also refer to the detailed instructions that come with the AutoTrace 
Replacement Kits. Refer to “Ordering Supplies” on page 163 to 
order Replacement Kits.

Contact Dionex Technical Support (see “Contact Us” on page 3) 
with any questions about maintaining the workstation.

Routine Maintenance
This section reviews the routine maintenance to be performed on 
the AutoTrace Workstation. Regularly observing AutoTrace 
operation and following the limited number of methods in Table 18 
will ensure optimum workstation performance.

Table 18. Routine Maintenance 

Task Description
Clean Periodically clean column holders, racks, and 

other workstation surfaces with warm, soapy 
water.

Flush Lines Flush the workstation’s solvent and sample 
lines if not using the workstation for an 
extended period. Refer to “Operation” on 
page 97.
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Check for Leaks Routinely check for tubing and syringe leaks. 
If a tubing leak is found, replace the tubing as 
necessary. If liquid is below the plunger-tip 
level inside any syringe, replace the syringe.

Check for Fitting 
Tightness

Make sure all syringe and valve fittings are 
finger tight.

Check for O-ring 
Wear

Check the O-rings at the bottom of the 
column holder for cracking or wear, and 
replace any O-rings as required.

Check Overall 
Performance

Check the overall workstation performance 
by running the utility method (see “Testing 
General Operation (Benchmark Test) Utility” 
on page 68). This utility checks the operation 
of the workstation front panel, elution station, 
syringes, pumps, and valves, and is 
described in detail at the end of this section.

Table 18. Routine Maintenance (Continued)

Task Description
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Replacing and Adjusting the Liquid Handling 
Syringe

This section explains how to replace and adjust the 10 mL liquid 
handling syringe.

Parts

The following item is required to complete this method:
• 10 mL replacement syringe

Purge the Solvent Lines

Follow these steps to purge the liquid handling syringe and its 
tubing.

1 Download a Purge Solvents procedure as described in 
“Purging the Solvent Lines Utility” on page 66.

2 Remove the solvent lines from their reservoirs.

3 Run the purge method to air-purge the liquid handling syringe 
and its tubing.

Center the Syringe Plunger

Follow these steps to center the syringe plunger and prepare the 
syringe for removal in the next method.

1 Run the Diagnostics menu option and download an Adjust 
Liquid Syringe diagnostic as described in “AutoTrace 
Diagnostics” on page 114.

2 Press the CONT button twice slowly.



Maintenance 129

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Remove the Defective Syringe

To remove the defective syringe:

1 Remove the two screws from the mounting bracket that secure 
the syringe to the housing, as shown in Figure 69.

Figure 69. Syringe Screws and Mounting Bracket

2 Remove the black thumbscrew from the bottom of the syringe 
plunger.

3 Gently slide the syringe assembly out of the housing.

4 Loosen the small black thumbscrew on the mounting bracket.

5 Holding the black mounting bracket in your left hand and the 
syringe in your right hand, turn the syringe counterclockwise 
until it disengages from the fitting.

6 Separate the syringe from the fitting.

Housing

Black Mounting

Fitting

Screw

Thumbscrew

Plunger

Driving Arm

Black Thumbscrew

Bracket

Stainless Steel
Tubing
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Mount the New Syringe

To mount the new syringe:

1 Slide the new syringe into the fitting. When aligned, turn the 
syringe clockwise to secure it in the fitting.

2 Tighten the small black thumbscrew on the mounting bracket.

3 Slide the syringe assembly into the housing and secure the 
mounting bracket, using the two screws previously removed.

4 Gently pull the syringe plunger down until it contacts the top of 
the driving arm.

5 Secure the plunger to the arm with the black thumbscrew 
previously removed.

Adjust the New Syringe

To adjust the new syringe:

1 Loosen the knurled thumbscrew approximately two turns, as 
shown in Figure 70.

Figure 70. Syringe Knurled Thumbscrew

Stainless Steel Tubing

Compression Screw

Knurled Thumbscrew

Thumbwheel

Driving Arm
Plunger
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Adjust the New Syringe (Continued)

2 Turn the thumbscrew to the left until the knurled thumbscrew 
moves to its upper limit of travel.

3 Loosen the white compression screw at the top of the syringe 
one to two turns.

4 Press the CONT button twice quickly to rerun the ADJUST 
LIQUID SYRINGE diagnostic. As the plunger moves up, you 
should hear a “clicking” sound.

5 Turn the thumbwheel to the right until the “clicking” just stops. 
Then turn it one more partial turn, as shown in Figure 71.

Figure 71. Thumbwheel Rotation

6 Tighten the knurled thumbscrew to secure the position.

7 Slide the stainless tubing down into the syringe as far as it will 
go. Press the CONT button twice to rerun the diagnostic.

8 Check that, as the plunger moves to the top, it moves the 
stainless tubing to the correct height.

9 After the plunger has pushed the stainless tubing to the correct 
height, tighten the white compression screw.

Thumbwheel

Top View

Turn thumbwheel one 
more partial turn to the 
right by the amount shown.
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Replacing and Adjusting the Air Syringe
This section explains how to replace and adjust the 10 mL air 
syringe.

Parts

The following item is required to complete this method:
• 10 mL replacement syringe

Center the Syringe Plunger

Follow these steps to center the syringe plunger and prepare the 
syringe for removal in the next method.

1 From the AutoTrace main menu, choose 
Diagnostics→Syringes: Adjust Air Syringe and download the 
Adjust Air Syringe diagnostic as described in “AutoTrace 
Diagnostics” on page 114.

2 Press the CONT button twice slowly.
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Remove the Defective Syringe

To remove the defective syringe:

1 Loosen the knurled knobs on both sides of the syringe clamp. 
Pivot the open end of the syringe clamp out of the way, as 
shown in Figure 72.

Figure 72. Syringe Clamp Knurled Knobs

2 Remove the black thumbscrew from the bottom of the syringe 
plunger.

3 Gently slide the syringe assembly out of the housing.

4 Loosen the Luer-Lock fitting between the tubing and the syringe 
by turning the lower fitting counterclockwise approximately ½ 
turn. Now, turn the syringe and remove it from the fitting.

Luer-Lock Fitting

Syringe Clamp
Housing Tab

Knurled Knob

Chrome
End Piece

Syringe Plunger
Driving Arm

Thumbscrew
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Mount the New Syringe

To mount the new syringe:

1 Insert the Luer-Lock fitting into the chrome end piece of the new 
syringe and turn the fitting clockwise until secure.

2 Align the grooves in the chrome end piece with the tabs in the 
housing.

3 Gently push the syringe into place.

4 Position the syringe clamp across the chrome end piece and 
secure it in place by tightening the knurled knob.

5 Gently pull the syringe plunger down until it contacts the top of 
the driving arm.

6 Secure the plunger to the arm with the black thumbscrew 
previously removed.

Adjust the New Syringe

To adjust the new syringe:

1 Loosen the knurled thumbscrew approximately two turns, as 
shown in Figure 73 on page 135.



Maintenance 135

Doc. 065296-01 1/09 AutoTrace SPE Workstation User’s Manual

 

Adjust the New Syringe (Continued)

Figure 73. Syringe Knurled Thumbscrew

2 Turn the thumbscrew to the left until the knurled thumbscrew 
moves to its upper limit of travel.

3 Press the CONT button twice quickly to rerun the ADJUST AIR 
SYRINGE diagnostic. As the plunger moves up, you should 
hear a “clicking” sound.

4 Turn the thumbwheel to the right just until the “clicking” stops. 
Then turn it one more partial turn, as shown in Figure 74.

Knurled Thumbscrew

Thumbwheel

Plunger
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Adjust the New Syringe (Continued)

Figure 74. Thumbwheel Rotation

5 Tighten the knurled thumbscrew to secure the position.

6 Press the CONT button twice quickly again to rerun the 
diagnostic. Confirm that the syringe drive mechanism is 
operating correctly. 

Thumbwheel

Top View

Turn thumbwheel one 
more partial turn to the 
right by the amount shown.
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Replacing Fuses
This section explains how to replace the fuse(s) in the workstation’s 
power entry port. The port is located on the right side of the unit. 
The method applies to single North American or single/dual 
international fuse configurations.

Parts and Tools

The following parts and tools are required to complete this method:
• Two 1.6A 220/240V fuses or one 3A 100/120V fuse
• Small flat-blade screwdriver

Refer to Figure 75 as required.

Figure 75. Fuse Replacement Details

Remove the Fuse Block Assembly

Follow these steps to remove the fuse block assembly.

NOTE

Power off the AutoTrace and unplug the AC power cord before 
beginning this method.

1 Turn the workstation’s power off and unplug the AC power cord.

2 Using the small screwdriver, place the screwdriver blade in the 
right side of the AC power socket. Now push the screwdriver 
blade to the right to pry the door open. 

3 Swing the power entry port door outward, toward you.

4 Hold the fuse block assembly and pull it out from the power 
entry port housing. 

Power Entry 
Port Housing

Fuse Block
Assembly

Fuse
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Replace the Fuse(s)

Follow these steps to replace the fuses.

1 Remove the fuse(s) from the fuse block assembly.

2 Press the new fuse(s) into place. Make sure the new fuse(s) are 
identical to the old fuse(s).

3 Slide the fuse block assembly into the power entry port housing 
and snap it into place.

4 Close the power entry port door.

5 Plug the AC power cord into an AC power outlet.

WARNING

Only plug the AC power cord into a properly grounded outlet. Only 
use a standard IEC 320-style power cord appropriate for your 
country.

6 Turn the workstation on.

7 Verify that the READY light comes on and the workstation 
operates normally.
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Calibrating Sample Pumps
This section explains how to run the CALIBRATE PUMP utility 
method. This method should be run only if the volume removed 
from the sample container does not match the sample volume 
requested in the method’s LOAD SAMPLE step.

Parts and Tools

The following parts and tools are required to complete this method:
• Allen wrench, 3/32-inch
• Sample container with approximately 120 mL of water/pump 

being calibrated
• Balance
• 1/16-inch ID tubing provided in Startup Kit

Calibration Method

Perform the following steps on each sample pump that requires 
calibration.

1 Perform a single-step CLEAN SAMPLE PATH method (as 
discussed in “Creating a Method to Clean the Sample Lines with 
Solvent and DI Water” on page 68), using DI water.

2 Download a Calibrate Sample Pumps procedure:

a From the AutoTrace main menu, choose Serial-
OP→Download Utility Procedure.

b Click the Calibrate Pump button.

c Read the online Help for this utility before continuing.

3 Press the CONT button twice slowly and follow the prompts on 
the front panel display.

4 As instructed, weigh the collection vessel before and after 
pumping. Determine the percentage difference between the 
expected volume of 100 mL and the delivered volume.

Example:

If the volume of water that the utility pumps is 103 mL rather 
than the expected 100 mL, the volume is off by 3%.

5 Locate the pump’s calibration screw in the hole on the right side 
of the pump, as shown in Figure 76.
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Calibration Method (Continued)

Figure 76. Pump Calibration Screw

6 Use the Allen wrench to adjust the screw as follows:

a ¼ turn clockwise to decrease the volume 2.5%

b ¼ turn counterclockwise to increase the volume 2.5%

Example:

For the example above, you would turn the adjustment screw 
clockwise approximately ¼ of a turn.

7 Rerun the calibration utility to test the change and make any 
further adjustments that are needed.

8 Repeat steps 3 through 7 for each sample pump to be 
calibrated.

Calibration Screw
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Benchmark Test Utility
This section explains how to run the Benchmark Test Utility method. 
Run this utility if there is any indication of trouble with the 
workstation, or if any of the following workstation components have 
been replaced: PC boards, tubing, valves, syringes, keypad, or 
column holder.

Parts

The following parts are required to complete this method:
• Six 16 x 100 mm test tubes and elution rack (for optional wet 

test)
• Sample container with at least 100 mL of water (for optional wet 

test)
• Solvent containers filled with colored water (for optional wet 

test)

Running the Benchmark Test

Perform the following steps to verify workstation operation.

1 Download a Benchmark Test procedure:

a From the AutoTrace main menu, choose Serial-
OP→Download Utility Procedure.

b Click the Benchmark Test button.

c Read the online Help for this utility before continuing.

2 Press the CONT button twice slowly and follow the prompts on 
the front panel display to verify that the:

a Front panel RUN light turns on.

b Front panel ERROR light turns on.

c Elution shuttle moves to its three different positions.

d Exhaust fan turns on.

e Holder’s LEDs are lit.
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Running the Benchmark Test (continued)

3 Perform the following wet test whenever tubing, valves, or 
syringes have been replaced. Follow the display’s prompts and 
do the following:

a Place empty tubes in the 16 x 100 mm elution rack.

b Place the workstation’s five solvent lines in containers 
holding water solutions of different colors.

c Observe that the tubes are filled with water as follows:

Tube #1 fills with 10 mL from solvent container #1.

Tube #2 fills with 10 mL from solvent container #2.

Tube #3 fills with 10 mL from solvent container #3.

Tube #4 fills with 10 mL from solvent container #4.

Tube #5 fills with 10 mL from solvent container #5.

Tube #6 fills with 10 mL from solvent container #1.

d With the gas turned on, verify gas valve operation by placing 
a finger under the elution manifold’s nozzles and sensing the 
gas flow.

e Place all sample lines in a container of water.

f Verify that all pumps direct sample to aqueous waste.

4 If you need to repeat the Benchmark Test, press the CONT 
button twice quickly.
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Column Holder Conversion
This section describes how to convert a column holder on an 
AutoTrace Cartridge version unit to work with a different size 
column.

Parts

To convert your column holder, obtain the appropriate plunger 
assembly for the column size to be converted. See “Ordering 
Supplies” on page 163.

Remove the Plunger Assembly

Follow these steps to remove the existing plunger assembly for all 
column holders to be converted.

1 Slide the tubing clamp up so that it is no longer over the 
stainless steel tubing, as shown in Figure 77.

Figure 77. Tubing Clamp Movement

2 Grasp the bottom of the Teflon tubing and carefully pull it 
upward until it slides off the top end of the stainless tubing.

3 Unscrew the plunger assembly (see Figure 77) and pull it down 
to remove it from the column holder.

LED

Teflon Tubing

Tubing Clamp

Stainless Tubing

Plunger Assembly
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Remove the Plunger Assembly (Continued)

4 Set the plunger assembly aside.

5 Repeat steps 1 through 4 for each column holder you need to 
convert.

Install the New Plunger Assembly

Follow these steps to install the new plunger assembly for each 
column holder to be converted.

1 Screw the new plunger assembly into position on the column 
holder.

2 Carefully, without developing kinks in the tubing, push the Teflon 
tubing end downward, over the top of the stainless tubing, as 
shown in Figure 78.

Figure 78. Teflon Tubing Installation

3 Now push the tubing clamp down until it is positioned as shown 
in Figure 79.

Teflon Tubing

Stainless Tubing

Push tubing down
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Install the New Plunger Assembly (Continued)

Figure 79. Tubing Clamp Positioning

Push clamp down
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Changing Between Column and 
Disk Versions

Procedure Scope
This procedure describes how to change the AutoTrace 
configuration from either Column to Disk or Disk to Column.

Tools Required
• Phillips screwdriver
• Slotted screwdriver

Parts Required
• Replacement SPE column holder
• Replacement SPE disk holder

Procedure Overview
1 Remove the existing column or disk holder.

2 Install the new column or disk holder.

3 Change the sample pump.

4 Reconfigure the AutoTrace software.
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Remove the Existing Column or Disk Holder
1 Turn the AutoTrace power off and unplug the power cord.

2 Slide the tubing clamp up so that it is no longer over the 
stainless steel tubing.

Figure 80. Disk or Column Holder

3 Grasp the bottom of the Teflon tubing and carefully pull it 
upward until it slides off the top end of the stainless tubing.

4 Disconnect the Teflon tubing from the lower end of the column 
or disk holder by unscrewing the compression screw.

5 Remove the screws that secure the rear cover. Set the cover 
and screws aside.

6 Locate the back of the holder you are replacing.

7 Follow the two sets of wires that lead from the back of the holder 
to the AutoTrace Column Interface board. Unplug the holder's 
two connectors from the board.

8 Carefully undo the cable attachments that secure the holder 
wires to the back of the workstation.

9 Remove the two top screws from the static strap. The static 
strap is on the back side of the column holder.

10 Remove the two Phillips screws from the front of the 
workstation, and remove the holder.

Tubing Clamp
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Install the New Column or Disk Holder
1 Insert the column or disk holder into the workstation and secure 

it in place with the two Phillips screws previously removed.

2 Carefully, without developing kinks in the tubing, push the Teflon 
tubing end downward, over the top of the stainless tubing, until 
there is a 1/8-inch gap between the bottom of the tubing and the 
top of the slider.

3 Now push the tubing clamp down until it is positioned as shown.

4 Connect the tubing to the lower end of the holder by finger 
tightening the compression screw in place.

5 Replace the two screws on the static strap.

6 Plug the two new holders’ connectors into the appropriate 
receptacles on the AutoTrace Column Interface board.

7 Secure the wires to the back of the workstation, using the 
supplied cable attachments.

Changing the Sample Pump
Prior to removing the pump, follow the steps below to create and 
run a procedure that will dry the line that runs from the pump to the 
switching valve. This prevents leaking during the replacement.

1 Open the AutoTrace software.

2 Log in to the AutoTrace software.

3 Click the Methods button on the toolbar to open the Setup 
Methods window.

4 Click the New button.

5 In the Name text box, type Dry Lines.

6 Double-click the AutoTrace Method Steps line in the left pane.

7 Expand the Solid Phase Extract option, double-click Load 
Sample, and set the volume to 10.0 mL.

8 Double-click Dry with Gas and set the time to 0.5 mins.

9 Save the method.
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10 From the main menu, choose Serial-Op→Download Method, 
choose the Dry Lines method, and click Yes when asked to 
download the method to the AutoTrace.

11 Place the sample lines in an empty, clean container.

12 Run the Dry Lines method.

13 When finished, turn off the AutoTrace’s power and unplug the 
power cord.

Removing the Defective Pump

1 One piece at a time, unscrew the pump’s compression screws 
and secure the tubing to the front of the workstation with a piece 
of tape.

Figure 81. Pump, Front View

2 Remove the screws that secure the rear cover of the 
workstation. Set the rear cover and screws aside.

3 Locate the back of the defective pump and follow the pump’s 
wires to the white connector that connects the pump to the 
wiring harness.

Figure 82. Pump, Back View

Compression
Screws

Tubing
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4 Squeeze the locking tab on the connector and separate the two 
connector halves.

Figure 83. Pump, Rear View

5 Remove the two screws that secure the pump to the pump 
mounting bracket. Set the screws aside.

6 Carefully pull the pump through the hole in the mounting 
bracket, angling the back of the pump downward to allow the tab 
on the front of the pump to clear the hole.

Installing the New Pump

1 Install the new pump by carefully placing it through the hole in 
the mounting bracket, angling the back of the pump downward 
to allow the tab on the front of the pump to clear the hole.

2 Replace the two screws that secure the pump to the pump 
mounting bracket.

3 Reconnect the two connector halves and check the wiring.

4 Replace the screws that secure the rear cover of the 
workstation.

5 Reconnect the pump’s compression screws and tubing.

6 Reconnect the power cord and turn on power to the AutoTrace.

7 From the main menu, choose Serial-Op→Download Utility 
Procedure and choose Calibrate Pump.

8 Follow the instructions in the Help screens to run the calibration 
utility.
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Reconfigure the AutoTrace Software
To reconfigure the AutoTrace software after converting the unit from 
Column to Disk or Disk to Column, you need to perform three steps:
• Erase the AutoTrace Dictionary.
• Edit the AutoTrace INI file (AT.INI) to reflect the disk or column 

version.
• Download the proper files and dictionary to the AutoTrace unit.

Erasing AutoTrace Dictionary

1 Close the AutoTrace software on the PC.

2 Open the HyperTerminal communication software.

3 Establish communication with the AutoTrace Workstation.

4 Type "Erase". When the software asks if you are sure, answer 
"Y".

5 Type "Dir" to make sure that the dictionary is empty.

6 Close the HyperTerminal software.

Changing the AutoTrace INI file

1 Locate the AT.INI file. The default path is:

C:\Program Files\Dionex\AutoTrace SPE Workstation

2 Open the AT.INI file, using Windows Notepad.

3 Find the following line:

Version = (x) [Where x = 1 (column) or 2 (disk)]

4 Change the version number to reflect your new configuration.

5 Save the AT.INI file and close it.

Downloading the New Dictionary to AutoTrace

1 Open the AutoTrace software.

The title bar should display the proper version (Cartridge or 
Disk).
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2 From the main menu, select Diagnostics→Initialization.

A DOS window opens. The window should state that the proper 
ZYOS file, and then the proper dictionary file, are downloading:
• BMAT133.BMD for column
• BMATD103.BMD for disk

This download will take several minutes to complete because the 
entire dictionary, files, and method are being downloaded.

Configuring HyperTerminal to Communicate with AutoTrace

In some cases, it may be necessary to communicate with the 
AutoTrace Workstation directly. HyperTerminal can be used to 
reconfigure the software when changing from Column to Disk 
versions of the AutoTrace. If there are conflicting dictionaries that 
have been downloaded onto the unit, HyperTerminal will need to be 
used to remove the extra files from the AutoTrace. HyperTerminal is 
a Microsoft Windows software accessory typically installed with 
Windows. The user should be familiar with this software to perform 
the following steps. Refer to Microsoft’s documentation for 
information on HyperTerminal.

Parameters
1 Follow the steps in HyperTerminal to set up a new connection by 

selecting a name and an icon.

2 In the connect to screen, select COM1. The COM1 Properties 
window opens, as shown in Figure 84.
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3 In the COM1 Settings screen, select the parameters shown in 
Figure 84:

Figure 84. COM1 Properties Window

4 Click the OK button.

5 From the main menu, select File→Properties. The Properties 
window opens, as shown in Figure 85.

Figure 85. Properties Window
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6 Click the ASCII Setup... button.

7 Select the parameters shown in Figure 86:

Figure 86. ASCII Setup Window

8 Click the OK button.

9 At the prompt, type DIR.

10 The following files should be listed:
• Zyos.zos
• BMAT133.BMD (for Cartridge version) or BMATD103.BMD 

(for Disk version)
• Method.BMD

If ERROR comes up on the screen, type DIR again. It may take 
several attempts to communicate. If communication still fails, 
check the parameter settings and COM port and try again.

11 Close HyperTerminal and reopen the AutoTrace software.

NOTE

Only one dictionary file should be listed (either BMAT133.BMD or 
BMATD103.BMD). If both files are on the AutoTrace, type ERASE to 
delete all the files. Close HyperTerminal and open AutoTrace 
software. Make sure the correct version is listed on the AutoTrace 
software title bar and download either a utility or diagnostic method.
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Voltage Conversion
This section of the manual describes how to set up the AutoTrace 
Workstation’s power entry port to correspond with the AC power 
source. The AutoTrace Workstation comes factory-configured for 
120V AC.

NOTE

Follow these steps only to convert the workstation’s voltage 
selection to a new voltage.

Power Entry Port

The power entry port contains a fuse holder compatible with dual 
220/240V fuses or a single 100/120V fuse. A voltage selector is 
also present that allows the voltage to be set to one of four 
configurations: 100, 120, 230, or 240 volts.

Parts and Tools

The following parts and tools are required to complete this 
procedure:
• Small flat-blade screwdriver
• Small Phillips screwdriver
• Needle-nose pliers
• Two 1.6A 220/240V fuses or one 3A 100/120V fuse

Refer to Figure 87 as required.

Figure 87. Fuse Block Assembly Removal

Power Entry 
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Card 
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Remove the Fuse Block Assembly

Follow these steps to remove the fuse block assembly.

NOTE

Turn off the AutoTrace power and unplug the AC power cord before 
beginning this procedure. 

1 Turn the workstation’s power off and unplug the AC power cord.

2 Using the small screwdriver, place the screwdriver blade in the 
right side of the AC power socket. Now push the screwdriver 
blade to the right to pry the door open.

3 Lift and swing the power entry port door outward, toward you.

4 Hold the fuse block assembly and pull it out from the power 
entry port housing. 

Select the New Voltage

Follow these steps to select a new voltage.

1 Using the needle-nose pliers, grasp the voltage selector card 
(located on the far right of the power entry housing) and pull it 
straight out.

2 Orient the voltage selector card so that the numbers indicating 
the desired voltage are positioned at the bottom of the card, as 
shown in Figure 88.

Figure 88. Voltage Selector Card
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Select the New Voltage (Continued)

3 Move the indicator pin so that it is positioned up when the card 
is held in the above position.

NOTE

When the indicator pin is fixed, each successive voltage is selected 
by rotating the card clockwise.

4 Reinstall the card in the housing with the printed side of the card 
facing toward the center of the housing and the pin facing out. 
The arrow on the pin will face the small arrows on the divider to 
the fuse housing.

Converting from 100/120V to 220/240V

Follow these steps to convert from a single 100/120 volt (3A) fuse 
to dual 220/240 volt (1.6A) fuses.

1 Remove the single 100/120V fuse, as shown in Figure 89.

Figure 89. 100/120V Fuse Removal

2 Invert the fuse block and install the two 220/240V fuses into 
place, as shown in Figure 90. 

Figure 90. 220/240V Fuse Installation
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Converting from 100/120V to 220/240V (Continued)

3 Slide the fuse block assembly into the power entry port housing 
and snap it into place.

4 Change the voltage on the voltage selector card.

5 Close the power entry port door and verify that the indicator pin 
shows the desired voltage.

Converting from 220/240V to 100/120V

To convert from dual 220/240 volt (1.6A) fuses to a single 
100/120 volt (3A) fuse, do the following.

1 Remove the dual 220/240V fuses, as shown in Figure 91.

Figure 91. 220/240V Fuse Removal

2 Invert the fuse block and install the single 100/120V fuse into 
place, as shown in Figure 92. 

Figure 92. 100/120V Fuse Installation

3 Slide the fuse block assembly into the power entry port housing 
and snap it into place.

4 Change the voltage on the voltage selector card.

5 Close the power entry port door and verify that the indicator pin 
shows the desired voltage.

Fuse Block

220/240V Fuse

220/240V Fuse

Fuse Block
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Verify Operation

Follow these steps to verify a successful voltage conversion.

1 Plug the AC power cord into an AC power outlet.

WARNING

Only plug the AC power cord into a properly grounded outlet. Only 
use a standard IEC 320-style power cord appropriate for your 
country.

2 Turn the workstation on.

3 Verify that the READY light on the workstation’s front panel is 
on.
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Specifications
Table 19 lists the specifications for the AutoTrace Workstation.

Table 19. Workstation Specifications 

Dimensions Workstation: 23 in (57 cm) wide x 25 in (63.5 cm) 
deep x 27 in (69 cm) high

Sample Rack: 12 in x 14 in (30 x 36 cm)
Weight 150 lbs (68.1 kg)
Electrical Voltage: 100, 120, 220, or 240 V (± 10%)

Frequency: 47 to 63 Hz
Power: 150 VA maximum

Liquid Management Air Syringe: One 10 mL air syringe
Liquid Handling 
Syringe:

One 10 mL liquid handling syringe

12-Port Valve: Rotary, sliding Rulon™ seal
Valves: 3-way, Teflon
Nozzles: Stainless steel
Tubing: TFE, 1/16-in ID, most lengths critical
Solvent Reservoir: 1 liter (2 total supplied)
Waste Reservoir: 10 liter (2 total supplied)

Solid Phase Extraction SPE Columns: 1 mL syringe-compatible columns
3 mL syringe-compatible columns
6 mL syringe-compatible columns
6 mL glass syringe-compatible 
columns
8 mL glass syringe-compatible 
columns

Column Plunger: Adapters available for four column 
types

Extraction Disks: 47 mm
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WARNINGS

• Do not use acetone as a solvent to clean the sample path or 
rinse the sample container because it is harmful to the sample 
pumps.

• Do not run pumps dry. Always leave DI water in the sample lines 
when the workstation is not in use. 

Collection Container 
Racks

Tube Racks: 16 x 100 mm stainless steel

Vial Racks: 11 mm GC, 17 x 60 mm, 4 mL screw 
cap

Conical Racks: 15 mL
Sample Pumps Displacement: Positive

Accuracy: ±2.5%
Tube Fitting: Kynar™
Piston and Liner: Ceramic
Restrictions: Not for use with acetic acid and 

acetone
Gas Regulator Output: 0 to 20 psi (0 to 1.4 bars)

Input: 100 psi (6.9 bars) maximum

Table 19. Workstation Specifications (Continued)
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Table 20 lists lengths and volumes for tubing in the AutoTrace 
Workstation.

Table 20. Tubing Lengths and Volumes 

Tubing from: Tubing to: Tubing Length: Volume:
12-port valve Solvent waste 7 ft (2.2 m) 3.36 mL

Solvent #1 7 ft (2.2 m) 3.36 mL
Solvent #2 7 ft (2.2 m) 3.36 mL
Solvent #3 7 ft (2.2 m) 3.36 mL
Solvent #4 7 ft (2.2 m) 3.36 mL
Solvent #5 7 ft (2.2 m) 3.36 mL
Switching valve #6 20 in (51 cm) 0.8 mL
Switching valve #5 20 in (51 cm) 0.8 mL
Switching valve #4 20 in (51 cm) 0.8 mL
Switching valve #3 20 in (51 cm) 0.8 mL
Switching valve #2 20 in (51 cm) 0.8 mL
Switching valve #1 20 in (51 cm) 0.8 mL

Air syringe Air valve (com) 5 in (13 cm) 0.2 mL
LH syringe (top) 12-port valve (com) 6 in (15 cm) 0.24 mL
LH syringe (side) Air valve (NC) 3.25 in (8.3 cm) 0.13 mL
Gas manifold Switching valve 10 in (25.4 cm) 0.24 mL
Switching valve Pump 34 in (86 cm) 1.36 mL

SPE cartridge 38 in (97 cm) 1.52 mL
SPE cartridge Elution station or 

elution manifold
24 in (61 cm) 0.96 mL

Pumps Sample containers 54 in (137 cm) 2.16 mL
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Ordering Supplies
To order more supplies for your workstation, use the part numbers 
listed in Table 21.

Table 21. Supplies List 

Item Part #
12-port Valve and Motor Replacement Kit 070293
12-port Valve Rotor Replacement Kit 070623
12-port Valve Stator Replacement Kit 071055
15 mL Conical Tubes (Case of 12) 071056
3 mL O-ring Kit (6) 071057
3-way Valve Replacement Kit 071058
47 mm O-ring Kit (6) 071059
6 mL O-ring Kit (6) 071060
Air Push Syringe Replacement Kit 071061
Column Holder Replacement Kit 071063
CPU Replacement Kit 071064
Disk Holder Replacement Kit 071065
Electronics Board Replacement Kit 071066
Elution Manifold Replacement Kit 071067
Elution rack for 11 mm GC vials 071068
Elution rack for 15 mL conical tubes 071069
Elution rack for 16 x 100 mm test tubes 071070
Elution rack for 17 x 60 mm vials 071071
Elution rack for 4 mL screw cap vials 071072
Front Panel Replacement Kit 071073
Glass O-ring Kit (6) 071074
Liquid Handling Syringe (Bag of 5) 071075
Liquid Handling Syringe Replacement Kit 071076
Module Adapter Board Replacement Kit 071077
Plunger assembly for 1 mL columns 071078
Plunger assembly for 3 mL columns 071079
Plunger assembly for 6 mL columns 071080
Plunger assembly for 6 mL or 8 mL columns 071081
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Sample input lines – column model (set of 6) 071082
Sample Pump Replacement Kit – cartridge model 071083
Sample Pump Replacement Kit – disk model 071084
Switching Valve Replacement Kit 071087
Teflon Tubing Kit (all tubing other than sample and 
waste)

071088

Waste Tubing Kit 071089

Table 21. Supplies List (Continued)

Item Part #
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Glossary
Table 22 lists the glossary terms and definitions.

Table 22. Glossary Terms 

Term Definition
Air Factor The adjustable factor that determines the distance 

liquid is pushed beyond the 12-port valve and 
switching valves. The air push factor is used in 
solvent conditioning and elute to soak steps and 
pushes the liquid partially through the column path 
so that the column bed is not dried out.

The number (from 0.3 to 5) increases or decreases 
the standard 1.2 mL amount of air that follows the 
liquid being sent through the solid phase extraction 
column by a factor of 0.3 to 5 times.

If volumes of greater than 5 mL are required, the dry 
with gas step in “Creating a Method to Clean the 
Sample Lines with Solvent and DI Water” is 
recommended.

Air Push A flow of air generated by the air syringe that clears 
liquid from the liquid handling syringe and tubing 
lines after conditioning, rinsing, eluting, and syringe 
washing steps.

AT A program that runs the AutoTrace menu software 
in the computer, allowing the download, setup, and 
writing of AutoTrace methods. This program also 
runs the diagnostic software that supplies a series 
of special diagnostic and service programs.

AutoTrace 
Method

Created when the method is entered into the 
AutoTrace menu software. This method is then used 
by the AutoTrace operating software to run the 
samples. (Earlier versions of software referred to 
“Procedure” instead of Method, but the terms have 
the same meaning.)

AutoTrace 
Software

Software that provides menu software for setting up 
the method in the computer, and operating software 
for running the method in the AutoTrace SPE 
Workstation.
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Flow Rates The speed (in mL/min.) at which to run the 
AutoTrace syringes. Flow rates for solid phase 
conditioning, loading, rinsing, and eluting 
operations are designated on the Setup Parameters 
screen.

Maximum 
Elution 
Volume

The maximum volume that can be eluted into the 
collection container, based on the container size.

Menu 
Software

The portion of the AutoTrace software on the 
computer that is used to set up, write, and review 
AutoTrace methods.

Method The list of steps used for implementing a laboratory 
application. (Earlier versions of software referred to 
“Procedure” instead of Method, but the terms have 
the same meaning.)

Operating 
Software

The portion of AutoTrace software that runs a 
method in the AutoTrace Workstation.

Procedure See “AutoTrace Method”
Push Delay The time (in seconds) to pause after liquid has been 

sent through the column, allowing the pressure to 
equilibrate.

Setup 
Parameters

The screen display of all changeable AutoTrace 
parameters. Every parameter listed begins with a 
default value. 

SETUP 
Program

The program used to install the AutoTrace software 
on the computer hard drive.

Table 22. Glossary Terms (Continued)

Term Definition
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